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HIGHLIGHTS
Here are just some of the things you can do with the X700 mobile phone.

• Send colour pictures and video clips 
to friends and family via Multimedia 
messaging and e-mail messaging.

• Send pictures, video, electronic 
business cards, and more using 
Bluetooth®, Infrared, or USB 
connections to other phones or devices.

• Swap content between appropriate 
devices with the included miniSD Card 
and adapter.

• Surf the Internet using your XHTML 
configured wireless Internet browser.

• Add frames, text, and pop art to VGA 
size images.

• Capture video clips.

• Play 40 tone polyphonic ringtones.

• No more wired headset! Use a 
Bluetooth® wireless headset.

• Synchronise your Contacts and 
Calendar with your other networked 
devices.

• See who is calling with picture Caller 
Line ID on the X700 external display.

• Download games, images, themes, 
sounds, videos, and Java™ and Series 
60 applications. 

• View all your media files in one place, 
the Media Gallery.

• Search for your files; including games, 
images, install packages, and video and 
sound clips.

• Receive, edit, and view Microsoft® 
Word, Excel, and PowerPoint® files. 
Beam documents to printers and 
projectors (with appropriate accessory).

• Speak a name or number to dial the 
number using Voice Commands.

• Say “open Messages” or “open 
Camera” and your phone will go directly 
to the application using Voice 
Commands.
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IMPORTANT INFORMATION
Thank you for purchasing this Panasonic digital cellular phone. This phone is designed 
to operate on GSM networks - GSM900, GSM1800 and GSM1900. It also supports 
GPRS for packet data connections. Please ensure the battery is fully charged before 
use.

Safety Considerations
Please read and understand the following information as it provides details for operating 
your phone in a manner which is both safe to you and your environment, and conforms 
to any legal requirements regarding the use of cellular phones.

This equipment should only be charged with approved charging equipment to ensure
optimum performance and avoid damage to your phone. Other usage will invalidate any
approval given to this equipment and may be dangerous. Ensure the voltage rating of the
Travel Charger is compatible with the area of use when travelling abroad. A Travel Charger
(EB-CAX70xx)* is supplied with the main kit. Car Charger (EB-CDX70) is also
recommended for charging. *Note: xx identifies the charger region, e.g. AU, CN, EU, UK,
US.

Use of a battery pack other than that recommended by the manufacturer may result in a
safety hazard. Never expose the battery to extreme temperatures (over 60º C or 140º F). It
is normal for your battery to become warm to the touch when charging. Camera use,
keeping Bluetooth switched on, Internet browsing, extended gaming, and downloading data
reduces battery life.

Cellular phones can cause interference in an aircraft. Switch off your cellular phone when in
an aircraft. The use of cellular phones in an aircraft may be dangerous to the operation of
the aircraft, disrupt the cellular network and may be illegal. Failure to observe this instruction
may lead to the suspension or denial of cellular phone services to the offender, or legal
action or both.

Alarms should not be set to switch on the phone when you are in an aircraft, near sensitive
medical equipment, at a refuelling point or when it may cause interference or danger.

Do not incinerate or dispose of the battery as ordinary rubbish. The battery must be
disposed of in accordance with local legislation and may be recycled. 

It is advised not to use the equipment at a refuelling point. You are reminded to observe
restrictions on the use of radio equipment in fuel depots, chemical plants or where blasting
operations are in progress. 

Never expose the battery to extreme temperatures (over 60º C or 140º F).

Power
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It is imperative that the driver exercises proper control of the vehicle at all times. Do not hold
a phone while you are driving; find a safe place to stop first. Do not speak into a handsfree
microphone if it will take your mind off the road. Always acquaint yourself thoroughly with
restrictions concerning the use of cellular phones within the area your are driving and
observe them at all times.

Care must be taken when using the phone in close proximity to personal medical devices,
such as pacemakers and hearing aids.

For most efficient use hold the phone as you would any normal phone. To avoid
deterioration of signal quality or antenna performance, do not touch or cup the antenna area
while the phone is switched on. Unauthorised modifications or attachments may damage the
phone and violate applicable regulations. The use of an unapproved modification or
attachment may result in the invalidation of your guarantee – this does not affect your
statutory rights.

When your handset, the accompanying battery, or charging accessories are wet, do not put
those in any type of heating equipment, such as a microwave oven, a high pressure
container, or a drier or similar. It may cause the battery, handset and/or charging equipment
to leak, heat up, expand, explode and/or catch fire. Moreover, the product or accessories
may emit smoke and their electrical circuits may become damaged and cause the products
to malfunction. Panasonic is not responsible for any and all damages, whether direct or
indirect, howsoever caused by any misuse. 

It is recommended that you create a copy or backup, as appropriate, of any important
information and data which you store in your phone’s memory. In order to avoid accidental
loss of data, please follow all instructions relating to the care and maintenance of your
phone and its battery. Panasonic accepts no liability for any and all losses howsoever arising
from any loss of data, including but not limited to direct and indirect losses (to include, but
not limited to consequential loss, anticipated savings, loss of revenue).

Your phone has the capability of storing and communicating personal information. It is
recommended that you take care to ensure that any personal or financial information is
stored separately from your phone. You should use security features, such as the SIM lock
to protect information held in your phone. Panasonic accepts no liability for any and all
losses howsoever arising from any loss of data, including but not limited to direct and
indirect losses (to include, but not limited to consequential loss, anticipated savings, loss of
revenue).

Your phone has the capability of downloading and storing information and data from external
sources. It is your responsibility to ensure that in doing this you are not infringing any
copyright laws or other applicable legislation. Panasonic accepts no liability for any and all
losses howsoever arising from any loss of data or any such infringement of copyright or
intellectual property rights, including but not limited to direct and indirect losses (to include,
but not limited to consequential loss, anticipated savings, loss or revenues). 
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You are advised to take appropriate care over the use of the internal camera. It is your
responsibility to ensure that you have permission to take photographs of people and objects
and that you do not infringe any personal or third party rights when using the camera. You
must comply with any applicable international or national law or other special restrictions
governing camera use in specific applications and environments. This includes not using the
camera in places where the use of photographic and video equipment may be prohibited.
Panasonic accepts no liability for any and all losses howsoever arising from any
infringement of copyright or intellectual property rights, including but not limited to direct and
indirect losses. 

Do not leave the camera facing direct sunlight, as this may impair its performance.

The colour liquid crystal display (LCD) uses high-precision production technology, and in certain
circumstances pixels may appear brighter or darker. This is due to characteristics of the LCD and is not a
manufacturing defect. 

The display layouts and screenshots within this document are for illustrative purposes and may differ from
the actual displays on your phone. Panasonic reserves the right to change the information in this document
without prior notice.

This equipment should only be used with Panasonic approved accessories to ensure optimum
performance and avoid damage to your phone. Panasonic is not responsible for damages caused by using
non-Panasonic approved accessories.

This Panasonic mobile phone is designed, manufactured and tested to ensure that it complies with the
specifications covering RF exposure guidelines applicable at the time of manufacture, in accordance with
EU, USA FCC, and Australian ACA regulations.

Please refer to our website for latest information/standards and compliance in your country/region of use.
http://www.panasonicmobile.com

CARE AND MAINTENANCE
Pressing any of the keys may produce a loud tone. Avoid holding the phone close to your ear
while pressing the keys.

Extreme temperatures may have a temporary effect on the operation of your phone. This is
normal and does not indicate a fault.

If you use your phone in a temperature over 40°C for a long time, the display quality may
deteriorate.

Do not modify or disassemble the equipment. There are no user serviceable parts.

Do not subject the equipment to excessive vibration or shock.

Do not drop the battery.

Camera
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Avoid contact with liquids. If the equipment becomes wet immediately remove the battery and
contact your dealer.

Do not leave the equipment in direct sunlight or a humid, dusty, or hot area.

Never throw a battery into a fire. It may explode.

Keep metallic items that may accidentally touch the terminals away from the equipment/battery.

Batteries can cause property damage, injury, or burns if terminals are touched with a conductive
material (i.e. metal jewellery, keys, etc.).

Always charge the battery in a well ventilated area, not in direct sunlight, between +5°C and
+35°C. It is not possible to recharge the battery if it is outside this temperature range.

When connecting the phone to an external source, read the operating instructions of the
equipment for the correct connection and safety precautions. Ensure the phone is compatible with
the product it is being connected to.

When disposing of any packing materials or old equipment check with your local authorities for
information on recycling.
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SAR
European Union – RTTE

THIS PANASONIC PHONE (MODEL EB-XXXX) MEETS THE EU REQUIREMENTS FOR EXPOSURE TO
RADIO WAVES.

Your mobile phone is a radio transmitter and receiver. It is designed and manufactured not to exceed the
limits for exposure to radio frequency (RF) energy recommended by The Council of the European Union.
These limits are part of comprehensive guidelines and establish permitted levels of RF energy for the
general population. The guidelines were developed by independent scientific organizations through
periodic and thorough evaluation of scientific studies. The limits include a substantial safety margin
designed to assure the safety of all persons, regardless of age and health.

The exposure standard for mobile phones employs a unit of measurement known as the Specific
Absorption Rate or SAR. The SAR limit recommended by The Council of the European Union is 2.0 W/kg*.
Tests for SAR have been conducted using standard operating positions with the phone transmitting at its
highest certified power level in all tested frequency bands. Although the SAR is determined at the highest
certified power level, the actual SAR level of the phone while operating can be well below the maximum
value. This is because the phone is designed to operate at multiple power levels so as to use only the
power required to reach the network. In general, the closer you are to a base station antenna, the lower the
power output.

Before a phone model is available for sale to the public, compliance with the European R&TTE directive
must be shown. This directive includes as one essential requirement the protection of the health and the
safety for the user and any other person. The SAR value for this model phone, when tested for use at the
ear, for compliance against the standard was 0.XXX** W/kg. While there may be differences between the
SAR levels of various phones and at various positions, they all meet the EU requirements for RF exposure.

*The SAR limit for mobile phones used by the public is 2.0 watts/kilogram (W/kg) averaged over ten grams
of tissue. The limit incorporates a substantial margin of safety to give additional protection for the public and
to account for any variations in measurements. SAR values may vary depending on national reporting
requirements and the network band.

**Right side of Head (Test Position: Cheek) Measurement results for GSM900.

For SAR information in other regions please look under product information at http://
www.panasonicmobile.com/health.html
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GETTING STARTED
The Panasonic X700 GSMTM/GPRS mobile phone operates on Global System for 
Mobile Communications (GSM) networks around the world, which provide integrated 
voice mail, text short message service (SMS), multimedia messaging service (MMS), 
fraud protection and superior voice quality. One of the most important GSM advantages 
is the removable SIM (subscriber identity module) card, containing personal information 
such as subscription information, private encryption keys, and phone numbers.

Feature Availability
Some features are network dependent or are available only if you subscribe to the 
feature. Some functions are SIM card dependent. Note that before you can use or 
activate many of the network features, you must subscribe to the desired services. For 
more information, contact your wireless service provider.

Before Using Your Phone
The SIM card must be installed in your phone for it to operate on the cellular network. 
Insert SIM card, then attach battery and fully charge it.

INSTALLING AND REMOVING SIM CARD

Installing SIM Card
1. Place thumbs at outer edges of battery cover, 

press down, then slide off battery cover 
towards bottom of phone. Remove battery (see 
page 8). 

2. Position SIM card as shown, with gold contacts 
facing phone and notched corner entering phone first. 
Carefully slide the SIM card into the SIM card pocket 
until it clicks.
• If SIM card is inserted incorrectly or damaged, 

Insert SIM card may display. Remove SIM card 
then install again.

• If SIM card rejected message appears, contact 
your wireless service provider.

Caution: This product contains small parts. Keep out of reach of small children.
Take care not to scratch or bend SIM card and gold contacts.
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Removing SIM Card
1. Place thumbs at outer edges of battery cover, 

press down, then slide off battery cover 
towards bottom of phone. Remove battery 
(see page 8).

2. Gently push bottom edge of SIM card forward 
into SIM card pocket to release SIM card. 

3. After SIM card is ejected, gently remove it.

INSTALLING AND REMOVING BATTERY

Installing Battery
1. Hold battery at a 45º angle; insert tabs on 

top edge of battery into slots along top 
edge of battery area.

2. Push bottom of battery down until it clicks.
3. Replace battery cover by sliding cover 

toward the bottom of the phone. Cover 
should fit snugly with no gaps.

Removing Battery

1. Place thumbs at outer edges of battery cover, 
press down, then slide off battery cover towards 
bottom of phone.

2. Use tabs at bottom of battery to lift and remove 
battery.

3. Replace battery cover.

Note: If you are upgrading your phone and your previous phone did not support new 
services, such as MMS (Multimedia Messaging Service), you may need to insert 
a new SIM card. Contact your wireless service provider. 

Caution: Using non-Panasonic accessories or accessories not recommended by your 
wireless service provider may result in poor performance of your phone, or 
even cause an electrical hazard.

Note: Before you remove the battery, switch off the phone and disconnect 
the phone from the charger or any other device.
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CHARGING BATTERY

1. Open connector cover.
2. Insert connector into left side (2 gold contacts) of connector area at bottom end of 

the phone. Connect the Travel Charger into mains power socket.
3. When charging is complete, remove from 

mains power socket and press release button 
to disconnect the charger from the phone.

• DO NOT force connector: it may damage 
phone or Travel Charger.

Charging Icons on Main and External Display
 bars scroll when charging

bars stop scrolling when charging is complete

• If the phone is switched on, Battery full message appears when charging is 
complete.

Low Battery Warning
When the battery power is low, Battery low displays and a warning tone sounds; phone 
will automatically switch off. Fully recharge the battery. If you receive the low battery 
warning during a conversation, finish your call immediately.

Note: First verify that battery is installed. 
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INSTALLING AND REMOVING miniSD CARD
The miniSD Card is a memory card used to expand phone memory and a way to 
transfer files to other devices.

Installing miniSD Card
1. On top of phone, lift up miniSD Card cover. 
2. Slide miniSD Card with notched corner entering phone 

first and gold contacts facing up into the miniSD Card 
pocket until it clicks. Push down miniSD Card cover until 
it clicks.

Removing miniSD Card
1. Press Power key , scroll to Eject miniSD Card and press OK. Before removing 

miniSD Card, wait for file saving or copying process to finish.
2. On top of phone, lift up miniSD Card cover.
3. To release miniSD Card, gently push bottom edge of 

miniSD Card forward into pocket. 
4. After miniSD Card is ejected, gently remove it. Push 

down miniSD Card cover until it clicks.

Note: Do not insert any object except a miniSD Card into the miniSD Card pocket.
Do not place labels, etc., onto the miniSD Card. A fine difference in card thickness 
may result in insertion or removal difficulty, loss of contact or loss of data.
Take care not to scratch or bend miniSD Card and gold contacts.
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PHONE OVERVIEW
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KEY FUNCTIONS
Key Function

Power Key
Press and hold to switch phone on or off.
Press to choose different ringtones, eject miniSD Card, lock keypad, or lock the 

phone.

Navigation Key
Press outside edges to scroll up , down , left  or right  to move through 

menus and text. 
Press centre  to select option.
In standby mode, press centre  to open Contacts.
Take a picture in Camera mode by pressing .

Send Key
Make a call.
Press in standby mode to recall recently dialled numbers. Scroll  to see received 

and missed calls lists.
Press and hold in standby mode to activate voice commands.

End Key
Ends a call.
Return to standby mode.

Applications Key
Enter the main applications menu area.
Return to standby mode.
Press and hold to view currently open applications.

Left Softkey
Perform action named in lower left of display.
Shortcut to open preset application in standby mode. To change shortcut, see 

page 94. 
To lock the keys, in standby mode press , then press . To unlock the keys, 

press , then press .

Right Softkey
Perform action named in lower right of display.
Shortcut to open preset application in standby mode. To change shortcut, see 

page 94.

Edit Key
Select Dictionary for predictive text including insert and edit words, or alpha mode or 

number mode.
Insert numbers or symbols. 
Change writing language. 
Mark multiple items in a list by holding down , then scrolling  or .
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Symbols used in this manual   

Clear Key
Erase character in edit mode.
Delete highlighted entered item.

Browser Key
Opens Browser.

Asterisk Key
In standby mode, press and hold to switch PhotoLight or flashlight on or off.
In numeric and standby modes, press repeatedly for *, +, p and w characters.
In Dictionary mode, scroll to other word choices when word is underlined.
In edit mode, press to open special character table.

Zero Key
In standby mode, press and hold to enter + character for dialling.
In edit mode, enter space.

Silent Mode Key
In standby mode, press and hold to switch Silent mode on/off.
In edit mode, shift to upper and lower case letters, or press twice briefly to turn on/off 

Dictionary for predictive text.

Multibutton (on side of phone)
From external display, turns on backlight for 15 seconds or if backlight is already on, 

brings up status icons.
Turns off ringer during incoming call.
Takes a picture in Camera mode when flip is closed.

Press Power key. Press Applications key.

   Press outside edges of navigation 
key to scroll up, down, left or right 
to move through menus and text.

Press navigation key centre.

Press Send key. Press End key.

Press Left softkey. Press Right softkey.

Press Edit key. Press Clear key.

 - Press number keys. Press Browser key.

Press Asterisk key. Press Silent Mode key.

Press Multibutton key (on side of 
phone).

Key Function
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ICONS
Different icons appear depending on the features you are using and the options you 
have selected.   

Icon Indicates Icon Indicates

Seven levels indicate battery charge 
level. Bars scroll when battery is 
charging.

Alarm is set

Seven levels indicate signal strength 
from network on which phone is 
currently registered

New voice mail message received (if 
you have 2 lines, left circle is 
darkened for line 1, right circle is 
darkened for line 2)

GPRS service is available New message received

GPRS service is on hold during 
voice call

Message in Outbox waiting to be 
sent

GPRS connection is active Bluetooth is enabled

Multiple GPRS connections are 
active Bluetooth is active

Missed call Infrared is enabled (flashes when 
active)

Call divert is active (if you have 2 
lines, 1 or 2 also appears) USB connection enabled

Line selection 2 
(SIM card dependent, if you have 2 
phone lines)

Navigation key - scroll and move up 
or down options

Data call Navigation key - scroll left or right, 
move left or right to view tabs

Keypad is locked All ringing tones/ring volume are off 
(Silent ringtone)

Earpiece sound on Private handsfree headset attached

Loudspeaker sound on
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STANDBY MODE DISPLAYS

MAIN DISPLAY

EXTERNAL DISPLAY

Press Multibutton once to switch on backlight, then press as needed to toggle between 
clock and icon views.
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PHONE BASICS AND MANAGING CALLS
SWITCHING THE PHONE ON AND OFF
Press and hold .

MAKING CALLS
Check that phone is switched on, signal strength icon displays at least one bar , and 
your network operator logo displays before dialling a call.

Type in the Phone Number to Dial
1. From standby mode, enter the area code and phone number, and press .
2. To end the call, press .    

Use a Contact Card to Dial
From Contacts application:
1. Scroll to desired name card, press .

• If the card has several phone numbers stored, select the one you wish to dial.
To add information to your Contacts, see page 30 .

Use a SIM Directory Entry to Dial
From Contacts application:
1. Scroll  to SIM directory view.
2. Scroll to desired name, press .

To add names and numbers to your SIM directory, see page 30.

Note: If your SIM card is PIN protected, your PIN code will be requested. 
Enter the PIN code and press OK. See Security Settings on page 98.

Note: To erase a digit, press .
During a call, scroll  or  to adjust earpiece volume.

Warning: Closing the flip during a call will end the call, when set to default. 
To set the phone to keep the call connected when you close the 
flip, see Active clamshell in Call Settings on page 94.
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Speak the Name to Dial
To dial by saying the name of the person you wish to call: 
1. Press and hold . 
2. After the prompt to “Say a command”, say “Voice Dial”.
3. After the prompt to “Say the name or number”, say the full name of a person in your 

Contact list, including first name and last name.
4. The name is repeated, and the phone will begin dialling.

See page 106 for more Voice Command options.

Speed Dialling
If you assigned speed dialling keys (see page 105) to your frequently called numbers, 
you can dial them with 2 key presses.
1. From standby mode, press the preset speed dial digit key  -  then press .

• If Speed dialling is set to On, (see Call Settings on page 94), just press and hold 
the preset speed dial digit key to dial the assigned number.

Dialled Numbers, Received, or Missed Calls List
You can quickly dial previously dialled numbers, received call numbers, or numbers of 
calls you missed.
1. From standby mode, press .
2. From the list of Dialled numbers, scroll to desired entry and press  to dial.

• Scroll  to move to Received calls tab and Missed calls tab to select a number 
from either of those lists.

Automatic Redial
If you set Automatic redial to On in the Call Settings menu (see page 94), your phone 
will automatically redial the number up to 10 times under certain conditions, such as no 
answer, destination number is busy, network busy, or some connection errors.
Press Quit or  to stop automatic redialling.

Dial from Messages
If a received message contains a phone number, you can dial it from the Inbox 
message. You can also call the sender of an SMS text message.
From Messages application:
1. Open Messages. Scroll to Inbox and open.
2. Scroll to desired message and open. 

Note: Location number 1 may be reserved for voice mailbox number.
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3. To find the phone number within a message, press Options and select Find > 
Phone number, E-mail address, or Web address. When found, text and numbers 
will be underlined.
• To call the sender of SMS text message from the open message, press  to 

dial the sender’s phone number.

International Calling
From standby mode, press and hold  to enter +, the international prefix, which is a 
shortcut for international dialling access. Then type in the country code, area code, and 
phone number. Press . 

Emergency Calls
Dial the local emergency number used in your current location.
1. Switch on the phone if it is off.
2. Verify that the antenna icon is displayed.
3. Enter the local emergency number (such as 112) and press . 

Send Service Command to Network
Ask your wireless service provider to activate a particular service by sending a service 
command. These commands, which may be called USSD commands, can activate 
services such as mobile prepay and chat.
1. First, contact your wireless service provider for the proper service command code.
2. Type in the supplied service command code. If the phone recognises it as a 

supplementary service or USSD request, press Send service comm.

ANSWERING CALLS
When there is an incoming call, the phone rings and flashes green.

1. Open flip to answer a call.
• If flip is open, press  to answer a call.

Note: Many countries/regions include an initial 0 in the area code. In most 
cases, you should omit this when dialling international numbers. For 
further help, contact your wireless service provider.

Note: You can call the local emergency number even if the keys are locked.
Making emergency calls without SIM is country or network operator dependent.

Note: If the phone is set to a ringtone with vibrating alert on, the phone 
flashes green and vibrates instead of ringing.
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Mute Ringing Tone
To mute ringing tone, press  if flip is closed. If flip is open, press Silence . Then 
answer the call by pressing .

Change Answer Settings
To change the setting so a call will not be answered by opening the flip, see Active 
clamshell in Call Settings on page 94.

To answer by pressing any key except , , or , see Anykey answer in Call 
Settings on page 94. 

Divert Incoming Calls
To divert calls to your voice mailbox or another number, see Call Divert on page 101. 
Then you can press  or Reject softkey and incoming calls will be diverted.  
If you ignore the call by not pressing any keys, the call details appear on the Missed 
calls list.

ACTIVE CALL OPTIONS
When on a call, you can put the call on hold, mute the microphone, send touch tones for 
passwords, etc., and create multi-party calls, depending on network support.

Place Calls on Hold
To put a call on hold or release the call from hold, press Options and select Hold or 
Unhold.

If you are connected to 2 calls (an active call and a call on hold), press Options and 
select:   

Swap Put active call on hold and activate held call.
Transfer Connect an active call and held call, or incoming call to active or 

held call, and disconnect yourself from both calls, leaving the 
two callers to talk to each other.

Shortcuts: You can also press  to switch between Hold and 
Unhold on one call, or switch between one active and 
one held call (Swap). 
To end a held call and continue with the active call, 
press  and .
To end the active call and continue with the held call, 
press  and .
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HANDSFREE TALKING
To hear the caller’s voice from the handsfree loudspeaker, press Loudsp.. Set the 
phone down nearby so you and several others can have a conversation without holding 
the phone. 
To go back to the earpiece, select Handset.

If you have activated a Bluetooth handsfree headset, press Options and select BT 
Accessory to hear the caller’s voice in the Bluetooth headset.

Volume Control
Scroll  or  to increase or decrease volume of phone earpiece , phone 
loudspeaker , or if a headset is attached. Note the volume step bars change as you 
adjust volume.
To mute or unmute the microphone, press Options and select Mute or Unmute. Mute 
switches off microphone of phone and any accessory microphones if attached. Unmute 
switches microphone back on.

CALL WAITING
If you activated Call waiting network service in Call Settings (see page 94), you can 
answer an incoming call when on an active call.
1. During an active call, press  to answer an incoming call. The active call is put on 

hold.
• To switch between the calls, press Swap or .
• To end the currently active call and answer the incoming call, press Replace.

2. To end the currently active call, press . The held call becomes active.
• Or to end both calls at once, press Options and select End all calls.
• If you press and hold , all calls and data connections are ended.

To reject the incoming call, press Reject. The caller receives a busy message or goes to 
voice mail.

Send DTMF Touch Tones
DTMF touch tones can be transmitted during a call just by pressing the keys (0 to 9, #, *) 
on your phone. Touch tones are often used to access services such as voice mailboxes, 
calling card calls, and banking. 

During a call, press Options and select Send DTMF if you stored a DTMF touch tone 
sequence in a Contacts card. Press Find, scroll to desired entry and select. 

Loudspeaker icon -- handsfree is active.

Earpiece icon -- handsfree is not active.
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To dial or store touch tone sequences:
1. Type in access phone number.
2. Before entering touch tone digits, press  repeatedly to scroll through *, +, p and 

w characters to insert:
• a short pause before the digits are transmitted (p character).
• a manual wait period (w character) that requires you to press Send  during 

the call to transmit the digits.
• + character to send a touch tone sequence stored in a speed dial location (see 

page 105).
3. Enter the touch tone digits, for example, the access codes for your voice mailbox.
4. Press  to immediately dial call, or press Options and select Add to Contacts to 

store sequence in your Contacts (see page 30).

Open Applications During a Call
During a call, open the main application menu by pressing , then open the desired 
application, for example, check your Calendar for an upcoming meeting time. The active 
call remains connected and is indicated by a small pop-up window. To return to the 
active call window, exit the application.

If you press , an active call will always disconnect.

Play/Record Sound Clips During a Call
To play a sound clip during a call, open the sound clip from its current location and play. 
The other person hears the sound clip.
To record the current call, see page 112.

Multi-Party Calls
In a multi-party call, you can have a conversation with up to 5 different parties at the 
same time if supported by the network.
1. Call the first party.
2. After the call is connected, press Options and select New call to enter a number or 

press Find to go to the Contacts to dial a number and press . The first call is put 
on hold.

3. After the new call is answered, press Options and select Conference to join the 
held call and the active call together. From then on, there is only one active call, 
which is the multi-party call.

4. To add another party to the call, repeat step 2, then press Options and select 
Conference > Add to conference.

Note: You can enter multiple instances of pause, wait, and speed dial 
characters and touch tone sequences.
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5. To have a private conversation with one of the parties, press Options and select 
Conference > Private. Scroll to desired party and press Private. The separated 
party becomes the active call on your phone, the multi-party call is put on hold; 
however the remaining callers can continue with the multi-party call. To return to 
multi-call, press Swap. To return Private call to multi-call, press Options and select 
Conference > Add to conference.

6. To drop a party from the multi-party call, press Options and select Conference > 
Drop participant.  Scroll to desired party and press Drop. 

7. To end the multi-party call, press . 

ENDING CALLS
There are several ways to end a call:

• Close the flip.
• Press .
• Press End call softkey.
• Press Options and select End active call.

To end all calls if there are more than one:
• Press Options and select End all calls.

If you press and hold , all calls and data connections are ended.

See Active Call Options starting on page 19 for ending held calls, waiting calls, and 
multi-party calls.

CLOSE THE PHONE DURING A CALL
Closing the flip clamshell ends the call. This is the default setting for Active clamshell 
in Call settings. If you want to close the phone and speak handsfree during a call, 
change the Active Clamshell setting to Off. This setting switches the caller’s voice to 
the back loudspeaker so you can speak handsfree.

To keep calls connected when you close the flip clamshell and prevent calls from being 
answered when the flip is opened, see Active clamshell in Call Settings on page 94.

Note: If you are on an active call and already have a held call, start at step 3.
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ENTERING TEXT
There are two main ways to enter text; using the predictive text dictionary to quickly 
enter words, or alpha mode in which each key is tapped until the planned letter appears.

DICTIONARY FOR PREDICTIVE TEXT ENTRY
Dictionary uses a predictive text system to enter words by pressing one key per letter to 
display the planned word, instead of pressing keys multiple times until each planned 
letter appears. 

For example, to enter “Call me.” in a message, press:

                
C a l l m e .

When you press the 6 key and the 3 key, the word “of” appears on screen, because the 
English dictionary ranks “of” as the most common word associated with the key presses 
6 and 3. To change the word “of” to “me”, press  once, and the word changes.

DISPLAY PLANNED WORD MATCHES
If the correct word does not display, press  repeatedly to scroll through an alternate 
word list. To choose from all the word matches, press  and select Dictionary > 
Matches.

ADD WORDS TO PREDICTIVE TEXT DICTIONARY
To add a word that is not already in the dictionary, press  and select Dictionary > 
Insert word. You can also add the word to the dictionary when Spell softkey appears.

GENERAL TEXT ENTRY
Enter text and numbers in one of three ways: 

Alpha mode - press each key repeatedly until planned letter appears

Dictionary mode - press one key per letter for dictionary to display planned word

 Numeric mode - enter numbers 

In both alpha mode and dictionary mode, choose from:
First letter capital All capitals
Lower case

Shortcut: To enter numbers while in alpha or dictionary mode, press and hold 
desired number key  - .
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To enter symbols, press  and select Insert symbol.

To enter text at a flashing cursor:
1. Press the number keys associated with the planned letters repeatedly until the 

planned letters appear on screen. 
• To enter text using the predictive text dictionary, press  and select 

Dictionary on, if it is not already active.
2. Editing actions for each key and shortcuts:

Cut, Copy, and Paste Text
1. To cut, copy, and paste text, move cursor to left of text you wish to copy. 
2. While holding down , press and hold  to highlight text.
3. Release keys to stop highlighting. 
4. Press  and select Cut or Copy. 
5. In message field, move cursor to new desired location, press  and select Paste.

Enter space.

Enter punctuation by pressing repeatedly.
In Dictionary mode, press , then press  repeatedly to 

scroll to other punctuation.
Erase a character.

Press and hold to switch between text and number modes.
Press to scroll through upper case, lower case, and first letter 

capital mode.
Press twice briefly to turn Dictionary on or off.
Turn Dictionary on or off.
Switch to number mode.
Insert symbols.
Change writing language.
In Dictionary mode, scroll to other word choices when word is 

underlined.
Press outer edges to scroll up, down, left, and right through text.
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NAVIGATING THE APPLICATIONS
To view the main applications window, press .

Navigation Key
Press the left, right, top and bottom edges of the navigation key to move around 
the display. 

Press  to:
• Open an application item
• Select a highlighted item
• Confirm a selection
• Take a picture with the camera

If an up or down arrow appears at the bottom of the display, scroll  or  to go to 
additional items.   

Tabs
There may be more files, folders, or pages associated with an 
application item, which can be viewed by moving right and left 
across the screen. This is indicated by tabs ,
arrows , or numbers near the top of the screen.  For example,
if you are viewing page 5 of 12 pages associated with a file, 5/12 
and arrows are displayed.
• Scroll  and  to move through the tabs and pages. 

Condensed Instructions
In this guide, to condense wording, statements are used such as “Press Options and 
select Open.” This means to press Options, highlight Open, and press Select. You 
may need to scroll within the menu to reach Open. Many menu items are available 
within Options menus and other menus, thus these shortcut statements will be used 
throughout the guide to indicate the same type of process.

Shortcut: To jump to and open one of the first 9 application items (if you have not yet 
scrolled), simply press the number key corresponding to the desired item’s 
location on the grid view. The grid view numbering system is: 

1 2 3

4 5 6

7 8 9
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In this guide, a statement such as ‘Select Send > Via multimedia’, means to scroll to 
Send, then scroll  to view the pop-up menu containing Via multimedia, then press  
or Select softkey to select Via multimedia. Within the pop-up menu, you may need to 
scroll to highlight Via multimedia.

Options Softkey
At the first level of each menu item, Options  appears as a way to organise or 
customise the menu system. The options change depending on the menu level you are 
viewing.

To open the Options menu:
• Press Options, scroll to highlight the desired action, then press  or press Select. 

These additional actions may be available in the Options menu:

Mark/Unmark
In menu items containing many files, you can mark specific files in which to perform an 
action. For example, you may wish to delete 5 images from your Images folder 
containing 29 images.

To mark an item or items:
1. Press Options and select Mark/Unmark > Mark to place a checkmark next to the 

desired file. Scroll to mark more items as needed, or select Mark all to mark all files.
2. Press Options, then select desired action such as Delete, Send, Move.

Open Open the item.
List view View the menu items in a list form. If you select this, the option 

changes to Grid view to view the menu items in a grid form.
Move Move the item to another place within the application system.
Move to folder Move the application item into a folder.
New folder Create and name a new folder.
Memory details > View information about items stored in the phone memory and 

memory card (also referred to as miniSD Card).
Exit Exit the menu item.

Remove or Delete Remove or delete an item or a marked item (see Mark/Unmark 
on page 26) on a list or grid, or press .

Rename Give a new name to the item.
Edit Change information you have already entered.
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To unmark an item or items:
1. Press Options and select Mark/Unmark > Unmark on a marked file to remove the 

checkmark. To unmark all files, select Unmark all. 

Menus within a Menu
A pop-up menu appears when more than one choice is available. 
For example, you can send a Contacts entry several ways: via text 
message, via multimedia, via e-mail, via Bluetooth, and via 
infrared. 

To enter a pop-up menu:
• Scroll , or press , or Select softkey.

To close a pop-up menu:
• Scroll , or press Cancel softkey.

Save Changes
In many cases when editing text or numbers, or changing a setting; press the Back 
softkey to automatically save changes.

MULTITASKING
You can work with more than one menu item simultaneously. For example, you can start 
creating a new message, rename an image, and begin creating a Contacts entry, all 
without losing the data you have already entered.

To keep a menu item open:
Press  to go to the standby screen. Pressing  does not close the open menu 
item. 

Opening and closing menu items
There are several ways to open menu items:
• Press .
• Press Options and select Open.

Shortcuts: To mark or unmark an item, hold down  then press .
To mark or unmark multiple items, hold down  then press and hold  or  of 
navigation key to scroll through desired items. Release  or  to stop marking.

Note: During a phone call,  terminates the call instead of acting as 
a shortcut to the standby screen.
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There are several ways to close menu items:
• Press Options and select Exit.
• Press Back until Exit softkey appears, then press Exit.
• Press Close.

Shortcut to swapping among open items
If you have several menu items open, you can press and hold  
to view a pop-up window and scroll to locate the desired open item. 
When you open the item, you will begin at the point where you 
were previously.
To close an open item from the pop-up window, scroll to desired 
item, press  and select Yes.

SEARCH OPTION
In certain menu items, a magnifying glass icon  
appears which allows you to search for a name, file or item.
To search, enter the first letter of the desired name or file. The phone finds and displays 
matching entries. To refine the search, enter two or more letters.

SHARED PHONE MEMORY
The phone’s memory capacity is shared by all images; text, multimedia and e-mail 
messages; Contacts cards; video and sound clips; ringtones; Calendar and Notepad 
notes; and downloaded applications stored on your phone. If you keep more files on the 
phone, then there is less memory available to store new files or run certain applications.
To decrease the amount of phone memory used: (1) store data on your miniSD Card; (2) 
delete data that is old, copied elsewhere or not being used; (3) delete messages with 
attachments from your Inbox after saving attachments to an application; (4) use the 
portrait format to take pictures with the Camera whenever possible. The portrait format 
file size is much smaller than standard format.
To view details of the phone memory and miniSD Card use, and amount of free 
memory: 
1. Press .
2. Press Options. 
3. Scroll to Memory details.
4. Then scroll  to choose phone memory or memory card (also referred to as miniSD 

Card).
Also see File Manager on page 117.   
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APPLICATIONS MENU MAP
The phone’s main application menus are listed below. The names listed represent the 
names in list view. The names may be slightly different in grid view.      

Note: The menus may not appear in the order or with the same icons as listed here. 
The order and icons vary according to your wireless service provider, or if you 
have customised your settings.

  Settings   Camera   Tools
Ringtone Profiles
Themes
Settings
Clock
Speed Dialing
Voice Cmds
PrintBoy Setup
About product

Calculator
Converter
Notepad
Voice recorder
miniSD Card
To-Do List
Application Mgr
File manager
PhotoLight
SIM Tool Kit 

(optional)

  Calendar   Contacts   Media
Media Gallery
PhotoBase
RealOne Player
Video Recorder

  Messages   Call Logs   Connectivity
Voice mailbox
Messages

Recent calls
Call duration
GPRS counter

Browser
Operator Menu
Modem
Bluetooth
Infrared
USB
Connection Mgr
SyncML
Device Mgr

  Games   Favourites   Quickoffice
MicroGolf
Balloon-Headed 

Boy

X700_OI.book  Page 29  Wednesday, September 1, 2004  6:47 PM



30      

CONTACTS
Store names, phone numbers, e-mail, web and street addresses, even a thumbnail 
picture in a Contact card. Call and send messages directly from Contacts. Numbers can 
also be stored on your SIM card. See Entering Text on page 23 to learn how to enter 
text.

CREATE NEW CONTACT CARDS
From Contacts application:
1. Press Options and select New contact.
2. Enter information in main fields:

First name Telephone
Last name Mobile
Company Fax
Job title E-mail

3. From main fields, press Options to: 

4. Press Done to save entry.

SIM DIRECTORY
The SIM Directory shows you the names and numbers stored on your SIM card. Your 
wireless service provider can program their service numbers, your wireless phone 
number and other numbers into your SIM card. You can store personal numbers on your 
SIM card as well. 

Unlike a Contacts entry, a SIM Directory entry consists of only one name and one phone 
number.

Copy Numbers to SIM Directory
1. From the Contacts list, highlight the desired card.
2. Press Options and select Copy to SIM direct.
3. Choose one of the phone number fields to copy, press OK.

Add thumbnail Place picture from your Images folder into the card.
Add or Delete detail Choose desired fields and icons from list including Job title, Tele-

phone, Tel. (home), Tel. (business), 3 mobile, 3 fax, pager num-
bers, 3 E-mail fields, 3 Web addresses, 3 street address fields, 
DTMF tones, Birthday, and Note.

Edit label Change the field name.

Note: See SIM Directory to create and copy entries into your SIM Directory.
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• If you select All, the phone creates a separate SIM directory entry for each phone 
number stored with that Contacts entry name.

Create and Manage SIM Directory Entries
1. From the Contacts list, scroll  to SIM directory tab.
2. Press Options and select from:    

FIND A CONTACT CARD
From Contacts application:
1. Scroll to desired entry, or enter the first letter of desired entry in . Entries 

beginning with that letter will display.
2. Press  to open entry.

MAKE A CALL
From Contacts application:
1. Scroll to desired Contacts entry and press .

Or, press Options and select Call.
• If entry contains more than one number, choose desired number to dial before 

pressing . 

Note: To copy SIM entries to your Contacts, highlight the desired SIM entry, then press 
Options and select Copy to Contacts.
The first time Contacts is opened after a different SIM card is placed in the 
phone, press OK if you wish to copy SIM contacts into the Contacts memory.

Call Call the highlighted entry.
New SIM contact Create a new SIM contact entry. Open and enter Name, then 

enter No. and press Done.
Edit Edit the highlighted SIM entry. Numbers stored by your wireless 

service provider cannot be edited.
Delete Delete the highlighted SIM entry. Numbers stored by your wire-

less service provider cannot be deleted.
Copy to Contacts Copy the highlighted SIM entry to your Contacts list.
My numbers View your own phone numbers.
SIM details View the number of used and free SIM entries.

Note: To make a call from the SIM directory, from Contacts application scroll  to 
SIM directory tab. Scroll to the desired entry and press .
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CREATE A MESSAGE
From Contacts application:
1. Scroll to the desired Contacts entry and press Options.
2. Select Create message > Text message, Multimedia message, or E-mail.
3. To complete Text messages, see page 42; or Multimedia messages on page 42; or 

E-mail messages on page 44.

EDIT CONTACT CARDS
From Contacts application:
1. Highlight desired Contacts card.
2. Press Options and select Edit.
3. Scroll to desired field to edit, begin entering data. If the field already has information, 

scroll  to move to editing point, press  to clear a letter or digit.
4. Press Options to:

5. Press Done to save entry.

Assign Default Number to Dial
For a Contact card, set a particular phone number or address that the phone will use 
each time you wish to call or write messages to that person.
From Contacts application:
1. Scroll to desired Contact card and open.
2. Press Options and select Defaults.
3. Highlight a field:

Phone number
Text msg. number
MMS number/address
E-mail address

4. Press Assign.
5. Scroll to the desired entry and press Select.

• Repeat steps 4 to 6 to assign default numbers to the other fields.

Add thumbnail Place picture from Images folder in phone memory or miniSD 
Card.

Add or Delete detail Choose desired fields and icons from list including Job title, Tele-
phone, Tel. (home), Tel. (business), 3 mobile, 3 fax, pager num-
bers, 3 E-mail fields, 3 Web addresses, 3 street address fields, 
DTMF tones, Birthday, and Note.

Edit label Change the field name.

Note: To remove a default assignment, select (no default).
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Assign a Ringing Tone
From Contacts application:
1. Scroll to desired Contact card and open.
2. Press Options and select Ringing tone.
3. Scroll to desired tone (after a brief pause tone will play). You can use tones already 

supplied; sent in messages (see page 46); downloaded (see page 76); or recorded 
(see page 111).   

To assign a ringing tone to a group, scroll  to move to Groups tab, scroll to desired 
group, and continue with step 3.

Assign Speed Dial
From Contacts application:
1. Scroll to desired Contact card and open.
2. Scroll to desired phone number field in which to assign the speed dial key, press 

Options and select Assign speed dial.
3. Press or scroll to desired number key and press Assign. An icon  denotes that a 

speed dial key has been assigned to this number field.

To make a call using speed dial, press the associated number key, then press .

To remove an existing speed dial key, from Contacts application:
1. Scroll to desired Contact card and open.
2. Scroll to speed dial phone number field, then press Options and select Remove 

speed dial.
See page 105 for speed dial options.

Go to Web Address
If a Contact card contains a web address, you can launch the Browser and go directly to 
the web address.
From Contacts application:
1. Scroll to desired Contact card and open.
2. Press Options and select Go to web address. 

Note: If tones do not play, change the phone’s ringtone to General 
or Outdoor to hear the tones.
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MANAGE CONTACTS LIST
From Contacts application:
1. Press Options and select Edit, Delete, or Duplicate.

Memory Used in Contacts
To view number of cards, groups used and amount of memory used, from Contacts 
application:
1. Press Options and select Contacts info > Memory.

Sort List by Last Name or by First Name
From Contacts application:
1. Press Options and select Settings.
2. Open the Name display field to sort the list either by Last name first or First name 

first.

SEND A CONTACT CARD
Before a Contact card can be sent by Messaging or to another device, it is converted to 
an electronic business card format known as vCard.
From Contacts application:
1. Scroll to desired Contact entry.
2. Press Options, scroll to Send > Via text message, Via multimedia, Via e-mail, 

Via Bluetooth, or  Via infrared.
3. To complete text messages, see page 42; or multimedia messages on page 42; or 

e-mail messages on page 44; or Bluetooth on page 82; or Infrared on page 84.

SERVICE NUMBERS
If your wireless service provider has stored service numbers on your SIM card, you can 
view and call the service numbers.
From Contacts application:
1. Press Options and select Service numbers.

CREATE AND MANAGE GROUPS
Place Contact entries into one group. Select the group name when addressing a new 
message, and your message is sent to each member of the group. For example, set up 
Business or Family group. See Messages starting on page 40 to learn how to send 
messages.

Note: See Mark/Unmark on page 26 to select more than one entry. 

Note: This feature is not available if the phone contains Chinese language.
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Create New Group
From Contacts application:
1. Scroll  to Groups tab.
2. Press Options and select New group.
3. Enter a name for the group and press OK.
4. Open the group name, press Options and select Add members.
5. Select desired Contact cards to add.

• To remove a member from a group, scroll to desired name, then press Options 
and select Remove from group.

Manage Groups
From Contacts application:
1. Scroll  to Groups tab.
2. Scroll to desired group, then press Options and select from: Open to view group, 

Delete group, Rename group, add Ringing tone for group.

To see if a person belongs to a group; or add a person to a group, from Contacts 
application:
1. Scroll to desired Contact card.
2. Press Options and select Belongs to groups or Add to group. When adding, 

select desired group and press Add.

TAKE A PICTURE AND ADD TO CONTACT CARD
From Camera application:
1. The main display acts as a viewfinder when the flip is open. The external display 

acts as the viewfinder when the flip is closed.
2. To snap the picture, press  if the flip is open. Or press the Multibutton  on the 

side of the phone if the flip is closed.
• The image is saved in your Images folder in Media Gallery.

3. Open Contacts.
4. Highlight desired Contacts card.
5. Press Options and select Edit.
6. Press Options and select Add thumbnail.
7. Select Phone memory.
8. Open Images folder. Scroll to highlight the image and press Select.
9. Press Done.  
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CALENDAR
Keep track of upcoming meetings, appointments and special dates. Set alarms to 
remind you of upcoming events. Calendar events can be sent and received as 
vCalendar messages and synchronised with other devices to keep track of your 
schedule.

CREATE CALENDAR EVENTS
From Calendar application:
1. Press Options and select New entry > Meeting -- events with a start and end time, 

Memo -- events such as trips or vacations, or Anniversary -- single day events 
such as birthdays and anniversaries.

2. Enter information in most fields by entering numbers or letters:

3. Press Done to save event.

Set Calendar Alarm
When you set the alarm to On, scroll  to set the alarm time and date.
When the alarm rings, press Stop  to stop the alarm. Press Snooze  or any 
other key to snooze the alarm. 

Set Event Repeat Cycle
When an event occurs regularly; for example, baseball practice or music lessons, open 
the Repeat field to set interval time periods such as Weekly or Monthly.

Meeting Memo Anniversary
Subject Subject Occasion
Location Start date Date
Start time End date Alarm
End time Synchronisation Synchronisation
Start date
End date
Alarm
Repeat
Synchronisation

Shortcut: If you start typing after opening the Calendar, you are 
automatically entering the subject in a Meeting entry.
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Set Synchronisation
If you synchronise your Calendar events with a PC, you can set the privacy level.
• Set to Private to hide events from online viewers. 
• Set to Public to allow online viewers to see the event.
• Set to None if you do not wish to synchronise the event with your PC calendar. See 

Synchronisation on page 85.

BROWSE CALENDAR
View the calendar by day, by month, or by week.
To change view, press Options and select Month view or Week view.

CALENDAR ICONS
 Meeting Memo Anniversary

Month View
Scheduled event -- triangle in the lower right corner of a date.
Current date -- underlined. 
Selected date -- boxed; date also appears in the navigation bar.
Far left column -- the year’s week number (see Week view title in 
Settings).

Week View
Days of the week are displayed in columns. Each hour of a day is 
denoted by a cell.
Meeting events -- a colour bar during the scheduled time periods.
Memo and Anniversary icons -- appear between 7am and 8am
Current weekday -- underlined (if you are viewing the current 
week).
Selected date -- boxed; date also appears in the navigation bar.
Screen title -- either the week number or the week dates of the current week, depending 
on Calendar setting.

Shortcuts: Scroll     to move around the calendar.
Press Options and select Go to date to go to a desired date.
Press  to go to today.
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Day View
To view a certain day, scroll to the date and open.
Scheduled events are listed.

EDIT CALENDAR EVENTS
1. Scroll to desired date in any view and open.
2. Scroll to scheduled event and open. Edit desired fields.
3. Press Done when finished.

DELETE EVENTS
1. Scroll to desired date in Month or Week view, and time period in Week view and 

open.
2. Press Options and select Delete or press .

To delete multiple events:
1. View the calendar in Month view.
2. Press Options and select Delete entry > Before date to delete entries before your 

specified date, or All entries.

CALENDAR SETTINGS
From Calendar application:
1. Press Options and select Settings. Open each option:  

Calendar alarm tone Scroll to select desired tone (after a brief pause tone will play).
Default view Select Month view, Week view, or Day view.
Week starts on Choose starting day of the week.
Week view title Choose Week number of the year (e.g. Week 12) or Week 

dates (e.g. 20.03.05-26.03.05). 

Note: Week view title setting is available only if Week starts on is set to Monday. 
Week numbers are shown in layouts only if Week starts on is set to Monday.
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SEND CALENDAR EVENTS
Before a Calendar event can be sent by Messaging or to another device, it is converted 
to an electronic scheduling exchange format known as vCalendar.
1. From an open Calendar event in Day view, press Options and select Send > Via 

text message, Via multimedia, Via e-mail, Via Bluetooth or Via infrared.
2. To complete text messages, see page 42; or multimedia messages on page 42; or 

e-mail messages on page 44; or Bluetooth on page 82; or Infrared on page 84.

CHINESE LUNAR CALENDAR
Check Chinese Lunar Calendar dates and festivals when still viewing western Calendar 
information.

To display Chinese Lunar Calendar information:
1. From the open Calendar, press Options and select Settings.
2. Scroll to Lunar calendar. 
3. Select On.
4. To view Chinese Lunar Calendar detail, press Options and select View lunar data.

To turn off Chinese Lunar Calendar information:
1. From the open Calendar, press Options and select Settings.
2. Scroll to Lunar calendar.
3. Select Off.   

Note: Chinese Lunar Calendar will appear only when a Chinese language 
is selected as the phone display language.
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MESSAGES
Messages menu contains these main options:

VOICE MAIL
Voice mail service stores voice messages from callers who could not reach you. The 
messages are stored on your wireless service provider’s network, not on your phone. 
You must first subscribe to voice mail from your wireless service provider before using 
this service.

Listen to Voice Mail Messages
When you receive a new voice mail message, an alert sounds if ringtone is not set to 
silent, and the voice mail icon  displays.
1. Press and hold  in standby mode to dial your voice mail message centre.

• You can also press  and  in standby mode.
2. Follow the prompts to listen to your voice mail messages.

If the phone asks for the voice mailbox number, enter the voice mail message centre 
phone number given to you by your wireless service provider.

To change the voice mailbox number, from Messages application:
1. Open Voice mail.
2. Press Options and select Change number.

MESSAGES
Send, receive, and store messages from text message (SMS), multimedia (MMS), 
e-mail, service and cell broadcast. 

Messaging Types
SMS: Short Message Service allows you to send and receive short text messages to 
mobile phones with short text message capability on the same network or any network 
that has a roaming agreement. A small black and white picture message can be inserted 
in the message.
MMS: Multimedia Messaging Service allows you to send messages containing images, 
video clips, sound clips and text. Presentation templates are available to place media 
objects into prearranged layouts. Multimedia messages can be sent to another mobile 
phone with multimedia capability or to an e-mail address.
E-mail: Create, send and receive e-mail messages, which can have attachments.

Voice mail Messages
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Smart messages: Messages containing data such as electronic business cards, ringing 
tones, Java™ applications or configuration data such as WAP and multimedia settings.

These services do not work by sending messages directly to the recipient, instead they 
store and forward messages through specifically designated network servers. 

Before Using Messaging Services
Before you can use multimedia or e-mail messaging, your connection settings must be 
configured. 
Your multimedia configuration settings may already be set by your wireless service 
provider. If settings are not available, contact your wireless service provider.
Your e-mail configuration settings are provided by an Internet Service Provider (ISP) 
that supports POP3/IMAP4/SMTP protocols. 
Before you can send and receive e-mail:
(1) you need a subscription for data services, (2) contract must be set up with an ISP, (3) 
you must configure an Internet Access Point (see Access Point Settings on page 95). 

Messages Menu Main Options 

In some main Messages options, icons indicate the message type:

To view Cell Broadcast messages, see page 56.

New message
Create new messages.

Drafts
Stores unfinished messages.

Inbox
Stores received messages except e-mail and 
cell broadcast.

Sent
Stores sent messages.

My folders
Stores moved messages and templates.

Outbox
Temporarily stores messages waiting to be 
sent.

Mailbox
Receives and stores e-mail messages.

Reports
Delivery status on text, multimedia, and smart 
messages.

Text message Bluetooth Cell broadcast

Multimedia Infrared Unknown

E-mail WAP push Attachment

Smart
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CREATE NEW TEXT MESSAGES
From Messages application:
1. Open Messages.
2. Open New Message and select Text message.
3. In the To field, type in recipient’s phone number.

• To retrieve from Contacts card, press , or Options and 
select Add recipient. Scroll to desired name and press OK. 
Select desired number if entry has several numbers. 

• To separate multiple recipients, enter a semicolon (;) by 
pressing .

4. Scroll  to move to text entry field, enter text. 
5. If desired, press Options and select Insert > 

6. To send, press  or press Options and select Send.

CREATE NEW MULTIMEDIA MESSAGES
From Messages application:
1. Open Messages.
2. Open New message and select Multimedia message.
3. In the To field, type in recipient’s phone number or e-mail 

address.
• To retrieve from Contacts card, press , or Options and 

select Add recipient. Scroll to desired name and press OK. 
Select desired number if entry has several numbers. Card 
must have a phone number or e-mail address to be visible.

• To separate multiple recipients, enter a semicolon (;) by pressing . 
4. Scroll  to move to text entry field, enter text. 
5. If desired, press Options and select Insert > 

Picture Picture msg. from Media Gallery
Template Select from a list of sentences in which you fill in the blank

Note: Text messages have a 160 character limit. The counter keeps track 
of total characters available. If you use more than 160 characters, a 
new text message starts, but appears as one message or more at 
destination. You may be charged for more than one text message.

Image Image from your Images folder
Sound clip Sound clip from your Sound clips folder
Video clip Video clip from your Video clips folder
New image New image from Camera
New sound clip New sound clip from Voice Recorder
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6. To send, press  or press Options and select Send.

Create Presentation
Choose from four presentation templates to create an impressive multimedia show.
1. Complete steps 1, 2 and 3 in Create New Multimedia Messages on page 42.
2. Press Options and select Create presentation.
3. Select from the list of templates:

• Image template
• Video template
• Sm. image tem.
• Temp. with title

4. Highlight desired template, press Select.
5. Scroll to the video, text, or image region of the template to highlight it.
6. If desired, press Options and select Insert >    

7. Press Options and select: 

Slide Add new slide to message

Note: If multimedia messages are sent to devices without 
multimedia or e-mail capabilities, the recipient may receive 
a message containing a link to a web page.

Image Image from your Images folder
Sound clip Sound to play at start of show
Video clip Video clip from your Video clips folder
Note Note from Notepad (if a text region is highlighted)
New image New image from Camera
New slide Add new slide to show

Note: Available choices depend on region highlighted.

Send Send completed presentation
Full screen Edit in full screen view
Normal screen Edit in normal screen view with signal icon, slide number, and 

softkey labels in view
Edit text Start or stop text editing, change text colour
Preview message Preview entire message before sending
Remove > Remove image, sound clip, video clip, or current slide
Backgrnd. settings > Set background colour, add background image to current slide 

or entire presentation, remove background image
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8. To send, press  or press Options and select Send.

CREATE NEW E-MAIL MESSAGES
Before you can write an e-mail message, at least one mailbox must be configured. See 
page 48.
From Messages application:
1. Open Messages.
2. Open New message and select E-mail.
3. In the To field, type in recipient’s e-mail address.

• To retrieve from Contacts card, press , or Options and 
select Add recipient. Scroll to desired name and press OK. 
Card must have an e-mail address to be visible.

• To separate multiple recipients, enter a semicolon (;) by 
pressing .

4. Scroll  to enter recipients in Cc (courtesy copy) field and type subject in subject 
field (both fields optional).

5. Scroll  to move to text entry field, enter text. 
6. If desired, press Options and select Insert > 

7. To send, press , or press Options and select Send.
• To view, add, or remove attachments before sending, press Options and select 

Attachments.
• If phone is set to send e-mail during next connection to mailbox, then pending e-mail 

will be stored in Outbox. Change setting by pressing Options and selecting Sending 
options.

COMMON WRITING TASKS
• To cut, copy and paste text, see page 24.
• To save before sending, press Close. Message is automatically stored in Drafts 

folder.
• To match names in To and Cc fields to names in Contacts, press Options and select 

Check contacts.

Effect settings > Set transition effect between images and between slides

Image Image from your Images folder
Sound clip Sound clip from Sound clips folder
Video clip Video clip from Video clips folder
Note Note from Notepad
Template Select from a list of sentences in which you fill in the blank
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RECEIVE NEW MESSAGES
When you receive a new message, the standby screen displays a new message icon 

 and a note indicating the number of new messages. Press Show to read the 
message. If there is more than one message, press Show to open the Inbox, then scroll 
to the desired message header and open.

INBOX (RECEIVED MESSAGES)
Inbox stores received text, multimedia, and smart messages. Incoming Bluetooth; 
Infrared; WAP push; SIM; and voicemail, e-mail waiting messages are also placed here.

The messages remain in the Inbox until you move them to My folders or delete them.
Unread messages have incoming arrow appearing with icon that identifies type of mes-
sage.
Read messages have no arrow with icon.

Read or Play Inbox Messages
From Messages application:
1. Open Messages.
2. Scroll to Inbox and open.
3. A list of message headers displays, indicating type of message sender (Multimedia, 

Bluetooth, etc.) and icon. Scroll to desired message header and open.
• The message may first need to be retrieved from the network server depending on 

the message type or if it contains large files.
• Press Play if needed for video clips, sound clips and presentations.
• If the message contains an image, it opens automatically.

Reply to and Forward Inbox Messages
From Messages application:
1. Open Messages.
2. Select Inbox.
3. Scroll to desired message, press Options and select Reply  > To sender or To all 

or Forward.
4. To reply, enter text in text field.

To forward, enter recipient(s) phone numbers or e-mail addresses.
5. Press .

Note: Scroll  to decrease or increase audio volume.

Note: The phone may not allow you to copy, modify, transfer, or forward 
some copyrighted images, ringtones and other content.
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Store Inbox Messages
From Messages application:
1. Open Messages.
2. Select Inbox.
3. Highlight desired message.
4. Press Options and select Move to folder.
5. Choose a folder and press OK.

Save Attachment or Data
You can save images and media clips from messages. Attachments to e-mail, links to 
streaming media, Contacts cards, Calendar items, ringtones, and configuration data can 
also be saved.
1. Open desired message.
2. Press Options and select Save.

• If needed, the data is directed to the appropriate application.
3. If needed, select to save either in phone memory or miniSD Card, press OK.
4. If needed, scroll to desired folder to place object or attachment, press Open or 

Save. If desired, rename the file. Press Save.

Find Phone number, E-mail or Web Address in Message
Within received messages, you can find a phone number, e-mail or web address within 
message text and use it to call, write, access a service or create a Contacts card.
From Messages application:
1. Open Messages.
2. Scroll to Inbox or My folders and open.
3. Scroll to desired message and open. 
4. Press Options and select Find > Phone number, E-mail address, or Web 

address.
5. Text and numbers are highlighted when found. If more than one is found, scroll to 

highlight desired item.
6. Press  to Send a message, Add to Contacts to add or update Contacts, Call a 

number, Go to web address, or Add to bookmarks to add web address to 
bookmarks. 

Note: Received applications or games can be installed directly from the Inbox. 
When you open the message, the phone asks if you want to install it now.
An attachment or object remains in the Inbox after it is saved to another 
application. To save memory space, delete message from Inbox.
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MY FOLDERS (ORGANISE MESSAGES) 
Store your messages in My folders. You can also create and name new folders. For 
example, create a folder for Friends and one for Family messages. Folders can also be 
created by message type or by subject.
From Messages application:
1. Open Messages.
2. Select My folders.
3. Press Options and select New folder.
4. Enter a name for your folder and press OK. 

To rename or delete a folder, from Messages application:
1. Open Messages.
2. Select My folders.
3. Scroll to desired folder, press Options and select Rename folder or Delete.

Templates
Templates are short sentences in which you fill in the blank, then send the message. 
Template sentences can also be inserted into longer messages.
From Messages application:
1. Open Messages.
2. Select My folders. Select Templates.
3. Scroll to desired text. Press Options and select Send > Via text message, Via 

multimedia, or Via e-mail.
4. Press  and a new message opens with template text already placed. 
5. Fill in needed information and press .

To create your own template text, from Messages application:
1. Open Messages.
2. Select My folders. Select Templates.
3. Press Options and select New template.
4. Enter text, numbers, or symbols, and press Done.

Note: You cannot create folders within a folder.

Note: In longer messages, at cursor, press Options and select 
Insert > Template. Template text is placed at cursor.
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MAILBOX (E-MAIL MESSAGES)
E-mail is received and stored in a separate mailbox. Once you set up a mailbox, Mailbox 
will be renamed and appear with its new name in the main Messages list. You can set 
up to 6 mailboxes, each appears separately in the main Messages list.

After your e-mail is set up, use the mailbox to view and send e-mail. Files such as 
images, sound and video clips can be attached from phone memory or miniSD Card. 
Supported e-mail clients include a standard POP3, IMAP4, SMTP, MIME client. E-mail 
messaging takes place over CSD and GPRS bearerset using standard Internet e-mail 
protocols over TCP/IP.

Configure Mailboxes
From Messages application:
1. Open Messages.
2. Press Options and select Settings.
3. Scroll to E-mail and open.
4. Highlight Mailboxes and open.
5. Press Options and select New mailbox.
6. Enter information in fields. Fields marked in the phone with a red asterisk (*) must 

have an entry. 

Note: Before you can send or retrieve e-mail, you must first set up a mailbox.

Mailbox name Use default name or enter a name for your mailbox and press 
OK.

* Access point in use Default Access Point supplied by wireless service provider
* My e-mail address Enter your own e-mail address and press OK. May be supplied 

by wireless or Internet service provider.
* Outgoing mail 
server

Enter SMTP mail server address.

Send message Choose During next conn. or Immediately.
Send copy to self Select Yes or No.
Include signature Select Yes to enter a signature for outgoing  messages.
User name Enter a name to log into service provider remote mailbox.
Password Enter password. 
* Incoming mail 
server

Enter address of incoming mail server (POP or IMAP), supplied 
by service provider.

Mailbox type Select POP3 or IMAP4.
Security Select Off or On. Determined by Internet service provider.
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Select Mailbox Name to Use to Send E-mail
To select which mailbox to use to send e-mail messages, see page 55.
If you have more than one mailbox and you start to write a new message, the phone 
notifies you of the mailbox name that is currently in use. To change the mailbox, see 
page 55 to change Mailbox in use setting.

Create a New E-mail Message
To create a new e-mail message, see page 44.

Retrieve E-mail
You can view your mailbox either online or offline. When you are online, you see your 
messages stored on the remote server. When you are offline, you see messages 
retrieved from the remote server to your phone, or message headers if not yet retrieved. 
IMAP4 protocol allows you to retrieve messages without attachments, so large memory 
files can remain in your online mailbox and not be stored in the phone.
You can mark as read or delete messages, or copy them to another folder and view 
message details when offline. Your mailbox is synchronised to the server when you go 
online.
When you receive a new e-mail message, a new message notice appears on the 
standby screen.

To connect to your mailbox, from Messages application:
1. Open Messages.
2. Select Mailbox (or renamed mailbox). 
3. Press Options and select Connect.
4. Once you are connected, press Options and select Retrieve e-mail > New, 

Selected, or All.
• To select certain messages, use Mark/Unmark action.

5. Once messages are retrieved, you can read them offline. Press Options and select 
Disconnect.

APOP secure login 
(POP3 only)

Select Yes to use authenticated POP log in, encrypts password.

Retrieve attachment 
(IMAP4 only)

Select Yes or No to automatically retrieve attachment when 
message is fetched.

Retrieve headers 
(IMAP4 only)

Select All to retrieve all message headers, or select User 
defined and type in a number to retrieve only the latest headers.

X700_OI.book  Page 49  Wednesday, September 1, 2004  6:47 PM



50      

Read Messages Offline
From Messages application:
1. Open Messages.
2. Select Mailbox (or renamed mailbox). 
3. Press No when phone asks to connect to mailbox.
4. Scroll to desired message and open.

Reply to E-mail Messages
From Messages application:
1. Open Messages.
2. Select Mailbox (or renamed mailbox).
3. Highlight desired message.
4. Press Options and select Reply > To sender or To all. 

Copy E-mail Messages
From Messages application:
1. Open Messages.
2. Select Mailbox (or renamed mailbox).
3. Highlight desired message.
4. Press Options and select Copy to folder.
5. Choose from the appropriate folders and press OK.

Sort Message List
From Messages application:
1. Open Messages.
2. Select Mailbox (or renamed mailbox).
3. Press Options and select Sort by > Date, Sender, or Subject.

Save Attachment or Data
You can save attachments, such as Contacts cards, Calendar items, links to streaming 
media, and configuration data.
1. Open desired message.
2. Press Options and select Attachments >      

Open Open attachment in read-only mode.
Save Save attachment.
Send Send attachment via Bluetooth or via infrared. 

Note: Attachment cannot be opened, saved, or sent if it has not been retrieved.
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Add E-mail Address to Contacts Card
From Messages application:
1. Open Messages.
2. Select Mailbox (or renamed mailbox).
3. Open desired message.
4. Press Options and select Add to Contacts > Create new to create a new Contacts 

card using the sender’s e-mail address, or Update existing to place the sender’s 
e-mail address in an existing Contacts card.

5. Continue with Create New Contact Cards on page 30 or Edit Contact Cards on 
page 32.

Manage Mailboxes
From Messages application:
1. Open Messages.
2. Press Options and select Settings.
3. Scroll to E-mail and open.
4. Highlight Mailboxes and open.
5. Scroll to desired mailbox name and press Options and select Edit or Delete.

DRAFTS
Your unfinished text (SMS), multimedia (MMS), and e-mail messages that have not 
been sent are stored in the Drafts folder.
From Messages application:
1. Open Messages.
2. Scroll to Drafts and open.
3. Scroll to desired message and open.
4. Enter the rest of the information.
5. Press , or if desired press Options and select: 

Send Send message
Add recipient Send to more than one address
Insert > Insert items such as Picture, Image, Sound clip, Video clip, or 

Template, depending on what type of file the message type sup-
ports

Attachments (E-mail)
Objects (Multimedia)

Open, insert, or remove attachments or objects

Edit presentation  
(Multimedia)

Edit the presentation

Preview message 
(Multimedia)

Preview message before sending
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SENT
Text, multimedia, smart, and e-mail messages that have been successfully sent are 
stored in the Sent folder, which stores the last 15 sent messages.

Move Sent Messages to My Folders
From Messages application:
1. Open Messages.
2. Scroll to Sent and open.
3. Scroll to desired message, then press Options and select Move to folder.
4. Select desired folder and press OK.

View or Delete Sent Messages
To view or delete sent messages and objects or attachments, from Messages 
application:
1. Open Messages.
2. Scroll to Sent and open.
3. Scroll to desired message and open.
4. Press Options and select: 

Check contacts Match names in To and Cc fields to names in Contacts
Message details View details such as message size
Sending options View or change sending options depending on type of message

Attachments (E-mail)
Objects (Multimedia)

Open, save, or send attachments or objects

Delete Delete message, object or attachment
Message details View details such as message size
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OUTBOX
Outbox stores messages waiting to be sent, and messages that could not be sent; for 
example, connection to the network failed. 

It also temporarily stores Bluetooth and Infrared messages that are waiting for 
connection to the receiving device. If the connection fails, Outbox does not keep the 
message.

The Outbox icon  appears on the standby screen when there are messages in the 
Outbox.
Status of Outbox messages:

Send, View, and Manage Outbox Messages
From Messages application:
1. Open Messages.
2. Scroll to Outbox and open.
3. Scroll to desired message. Press Options and select: 

Messages waiting in the Outbox are automatically resent (except e-mail set to send 
during next connection), depending on network availability.  
To cancel resending, from Messages application:
1. Open Messages.
2. Scroll to Outbox and open.
3. Scroll to desired message. Press Options and select Delete. 

Sending Connecting to network Waiting Waiting to connect

Queued E-mail waiting for connection Resend at If sending failed, resend attempt

Deferred Suspend sending to another time Failed Sending has not been successful

Defer sending Defer sending until you manually send
Message details View details such as message size
Send Send message now
Move to Drafts Move message to Drafts folder, where it can be edited and 

resent
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REPORTS
Delivery reports for text, multimedia, and smart messages can be sent by your wireless 
service provider, and stored in the Reports folder. Delivery reports are not available for 
e-mail messages.
From Messages application:
1. Open Messages.
2. Press Options and select Settings. 
3. For text messages, open Text message, scroll to Receive report and select Yes. 

For multimedia messages, open Multimedia message, scroll to Receive report 
and select Yes.

MESSAGE SETTINGS
Text Message Settings
From Messages application:
1. Open Messages.
2. Press Options and select Settings. 
3. Open Text message. Open fields as needed: 

Multimedia Message Settings
From Messages application:
1. Open Messages.
2. Press Options and select Settings. 
3. Open Multimedia message. Open fields as needed: 

Message centres Choose from provided list of network and SIM message centres 
Msg. centre in use Choose which message centre is used to deliver text messages
Receive report Choose Yes or No. If Yes, delivery reports showing status of 

sent text messages are stored in Reports folder.
Message validity Choose a time period from 1 hour to maximum in which text 

message delivery is attempted from the message centre.
Message sent as Choose Paging or E-mail if you wish to convert your text mes-

sage to one of those forms for sending. Available only if network 
can perform the conversion.

Preferred connection Choose GSM or GPRS connection.
Reply via same ctr. Select Yes to allow your text message recipients to use your text 

message centre to reply to you without having to subscribe to a 
text messaging service.

* Access point in use Choose from list of access points. See page 95 to create and 
edit access points. 
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E-mail Message Settings
From Messages application:
1. Open Messages.
2. Press Options and select Settings. 
3. Open E-mail. Open fields as needed: 

Service Message Settings
From Messages application:
1. Open Messages.
2. Press Options and select Settings. 
3. Open Service message. Open fields as needed: 

Cell Broadcast Message Settings
From Messages application:
1. Open Messages.
2. Press Options and select Settings. 

Multimedia reception Choose Only in home net., Always on or Off for incoming 
messages. 

On receiving msg. Choose Retr. immediately, Defer retrieval or Reject message 
for incoming messages.

Allow anon. 
messages

Select Yes to receive messages from anonymous (unknown) 
senders.

Receive adverts Select Yes to receive advertisements. 
Receive report Select Yes to receive delivery reports.
Deny report sending Select Yes so that your phone will not send a delivery report to 

confirm receipt of a new message.
Message validity Choose a time period for the message centre to attempt mes-

sage delivery.
Image size Select Small (default) for 160x120 (max) image size, or Large 

for 640x480 (max).
Default speaker Choose to play sound clips from Loudspeaker or Handset 

speaker.

Mailboxes View list of mailboxes you have set up.
Mailbox in use Select mailbox to use to send e-mail.

Service messages Select On to receive service messages.
Download messages Select Manually to allow only authorised senders to send ser-

vice messages.
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3. Open Cell broadcast. Open fields as needed: 

Other Message Settings
From Messages application:
1. Open Messages.
2. Press Options and select Settings. 
3. Open Other. Open fields as needed: 

SIM MESSAGES
To view, copy, or delete text messages stored on the SIM card, from Messages 
application:
1. Open Messages.
2. Press Options and select SIM messages. 
3. A list of messages stored on the SIM card appears. 
4. To view the messages, first copy them to the phone memory. Before copying 

multiple messages, use Mark/Unmark > Mark or Mark all to mark any or all desired 
messages to perform copying at one time. Press Options and select Copy.

5. Choose the desired folder to place the copy and press OK.
6. If desired, press Options and select Delete to delete messages from the SIM card. 

CELL BROADCAST MESSAGES
Cell broadcast messages are sent by your wireless service provider to GSM customers 
in a certain area. They provide general information about topics such as weather 
reports, traffic news, and customer services. Available topic names and numbers are 
supplied by your wireless service provider.

From Messages application:
1. Open Messages.
2. Press Options and select Cell broadcast. 

Reception Select On to receive cell broadcast messages.
Language Select All to receive cell broadcasts in all possible languages, or 

Selected to choose from a list, or Other if your preferred lan-
guage is not listed.

Topic detection Select On to view a list of topic indexes provided by the network.

Save sent messages Select Yes to save sent messages to the Sent folder.
No. of saved msgs. Type in a number to set maximum amount of messages saved 

to Sent folder.

Note: Leaving Cell broadcast set to On reduces battery life.
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3. Press Options and select: 

SERVICE COMMAND
Ask your wireless service provider to activate a particular service by sending a service 
command. These commands, which may be called USSD commands, can activate 
services such as mobile prepay and chat.
1. Contact your wireless service provider for the proper service command statement.
From Messages application:
2. Open Messages.
3. Press Options and select Service command.
4. Enter the service command, then press . 

Open Open topic
Subscribe or 
Unsubscribe

Subscribe to selected topic to receive related messages. Select 
Unsubscribe to stop receiving related messages.

Hotmark or 
Remove hotmark

When topic is hotmarked, you will receive a notice when related 
messages arrive.

Topic > Choose Add manually to type in a topic name or topic number 
or Delete all.

Settings See Cell Broadcast Message Settings on page 55 to turn on or 
off Cell broadcast reception, choose Cell broadcast language, 
and turn on or off topic detection.
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CAMERA
Take pictures to send in a multimedia or e-mail message, or for your Contacts cards. 
Pictures can also be sent via infrared or Bluetooth.

TAKE A PICTURE
From Camera application:
1. With the flip open, the main display acts as a viewfinder. Move 

the phone around to frame your subject.
2. To snap the picture, press .

• The image is automatically saved to Images folder. See 
Gallery on page 62.

To send the picture immediately, press . Scroll to Via 
multimedia, Via e-mail, Via Bluetooth, or Via infrared. To 
complete multimedia messages, see page 42; or E-mail messages 
on page 44; or Bluetooth on page 82; or Infrared on page 84. 

If you do not want to save it, either:
•  Press  and select Yes.
•  Press Options and select Delete.

Change Capture Modes
To choose different picture capture modes, scroll  to select: 
Standard regular size landscape pictures (640x480 pixels [VGA])
Portrait smaller pictures that use much less memory and can be placed in 

Contacts cards (80X96 pixels)
• Red number in upper right corner indicates the amount of pictures that can fit in 

phone memory, depending on selected image size.

Zoom
You can zoom in on your subject before taking a picture.
1. When viewing your subject in the viewfinder, press  once for 2x zoom, press  

again for 4x zoom. Press  to step back one zoom level.
2. Press  to snap the picture.

Note: Camera mode depletes battery power more rapidly. To conserve your battery, 
the phone shifts to camera standby mode after 1 minute if no keys are pressed.
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Self-timer
Set the camera to take a picture after setting the timer to delay the shutter.
1. From the viewfinder, press Options and select Self-timer > 10 seconds, 20 

seconds, or 30 seconds.
2. Move the phone around to frame your subject.
3. Press Activate to start the timer.

• The shutter sounds when the picture is taken.
• The image is stored in the Media Gallery Images folder.

Photolight
Light up your subject before snapping a picture. See PhotoLight on page 119.

TAKE A SELF-PORTRAIT
From Camera application:
1. Close the phone flip. The external display acts as a viewfinder. Move the phone 

around to frame your subject.
2. Press Multibutton  on side of phone to snap the picture.
3. Open the flip. The image appears on the main display. 

• The image is automatically saved to Media Gallery Images folder. To make 
changes to the image, press Options and select Go to Gallery. See Gallery on 
page 62.

To send the picture immediately, see Send Pictures on page 60. 

If you do not want to save it, press Options and select Delete.

SAVE PICTURES
Pictures are automatically saved in the Images folder in Media Gallery in phone 
memory, or you can save them on the miniSD Card. 
To save pictures to the miniSD Card, from Camera application:
1. Press Options and select Settings. 
2. Scroll to Memory in use and open.
3. Select NO NAME or the name assigned to your miniSD Card.

• All pictures are saved to the miniSD Card until this setting is changed to Phone 
memory, or miniSD Card is removed.

Note: To rename your miniSD Card, see miniSD Card (MEMORY 
CARD) on page 113.
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VIEW PICTURES
From Camera application:
1. Press Options and select Go to Gallery. A list of images stored in phone memory 

displays. Scroll to desired image and open.
• Or to view images in miniSD Card, press Back, scroll  to miniSD Card tab. 

Scroll to desired image or folder and open.

NAME PICTURES
To change the name that is used as the default file name for new images, from Camera 
application:
1. Press Options and select Settings. 
2. Open Default image name and enter desired text.

• For example, if you change the Image Name to SkiTrip, then your pictures will be 
named SkiTrip; SkiTrip(01); SkiTrip(02), etc. until the default name is changed.

3. To rename an individual image when you have taken a picture:
1. With saved image on main display, press Options and select Rename.
2. Enter a new name for the image.

PICTURE QUALITY
To choose the compression level (memory size) of future pictures:, from Camera 
application:
1. Press Options and select Settings. Open Image quality.
2. Select High, Normal, or Basic. The higher image quality you choose, the larger the 

file size will be.

If you plan to view pictures on a computer, use High or Normal picture quality so the 
quality will be better maintained when enlarged on a computer screen.

Basic picture quality is best when the pictures will be viewed on  phones and other small 
screens.

SEND PICTURES
Send the picture you just took to your family and friends.
1. With saved image on main display, press , or press Options and select Send > 

Via multimedia, Via e-mail, Via Bluetooth, or Via infrared. 
2. To complete multimedia messages, see page 42; or E-mail messages on page 44; 

or Bluetooth on page 82; or Infrared on page 84. 

Note: All three levels are 640 x 480 pixels resolution (sharpness). 
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Add a Picture to Contact Card
To add a picture to a Contact card, see Edit Contact Cards on page 32.

Incoming Calls when in Camera Mode
If you receive a call while in camera mode, the phone temporarily suspends camera 
mode and switches to the incoming call display. Once you answer the call, the screen 
returns to Camera mode and a small active call icon displays. If a captured image is on 
the preview screen, it is saved in the Media Gallery Images folder. 
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MEDIA
Media menu contains these main options:

GALLERY
Store, play, and manage your pictures, images, video clips, sound clips and streaming 
links (web addresses) in the phone memory or miniSD Card. Send media files to friends 
and family via multimedia, e-mail, Bluetooth, or infrared.
See Specifications on page 134 for supported media file formats.

VIEW IMAGE, SOUND, AND VIDEO FOLDERS
From Media application:
1. Open Gallery.
2. Phone icon tab shows data stored in phone memory, or scroll  to view data stored 

on miniSD Card. 
3. Select folder: 

VIEW IMAGES, ZOOM IN, AND SET AS WALLPAPER 
When an individual image is open, you can zoom in/out, rotate and view images full 
screen, and do other actions as listed below.
From Media application:
1. Open Gallery.
2. Phone icon tab shows data stored in phone memory, or scroll  to view data stored 

on miniSD Card. 
3. Open Images folder, then scroll to and open desired image.
4. Press Options and select: 

Gallery PhotoBase RealOne Player

Video Recorder

Documents See File Manager on page 117 to view your QuickOffice docu-
ments.

Images Scroll to desired image, or open Wallpapers folder to view wall-
paper files. Contact your network operator for availability of Pic-
ture msg. service.

Sound clips Choose Digital sounds folder or Tones folder.
Video clips Video clips.

Send > Send file to another device.
Set as wallpaper Set image as wallpaper in standby mode.
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Zoom, Rotate, and Panning Shortcuts
Zoom  zooms in;  zooms out;  zooms in, press again to activate full 

screen

Pan  and  pan up;  and  pan down;  and  pan left;  and  
pan right

Rotate  rotates clockwise;  rotates counter clockwise

Original Press and hold  to go back to original size view 

Full screen  switches between full screen view and original size view 
• If image is not zoomed, scroll  to go to next image in the current folder.

PLAY VIDEO, SOUND CLIPS, AND STREAMING MEDIA
Watch video clips and listen to sound clips, or play streaming media. Streaming media is 
sound and video stored and played back as it arrives from the Internet or your network 
servers; thus the file is not stored on your phone, taking up valuable memory.
From Media application:
1. Open Gallery.
2. Phone icon tab shows data stored in phone memory, or scroll  to view data stored 

on miniSD Card. 
3. Open desired folder(s), then scroll to and open desired video or sound clip. When 

choosing a link to streaming media, the phone begins connection process to the 
Internet or to your network.
• See Player Controls on page 64.

Rotate > Rotate image Left or Right in 90 degree steps.
Zoom in / Zoom out Zoom in or out in steps from 12.5% to 800%.
Full screen Removes status bar and softkey text to see more of the image.
Normal screen When viewing full screen, press , then select Normal 

screen to view status bar and softkey text.
Rename Rename the image.
View details View details such as file format and size, and image creation 

time and date.
Add to Favourites Add a shortcut to view image from Favourites.

Note: For streaming media, after the phone successfully connects to the 
link (web address of streaming media), there is a short loading 
period to prepare playback, then the streaming media begins 
playing. See Player Controls on page 64.
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Press Options and select from these additional options:   

PLAYER CONTROLS
Video controls 

Sound controls 
To select buttons on screen, scroll  or  to move box to button and press : 

Volume control
Scroll  to increase volume, scroll  to decrease volume (note bar scale near top of 
screen).
To mute the sound in a video clip, scroll  until muted speaker icon  appears. To turn 
sound back on, scroll . When playing sound clips, the lowest volume setting is level 1. 

SEND PICTURES, VIDEO AND SOUND CLIPS
From Media application:
1. Open Gallery.

Export to miniSD Copy or move file to miniSD Card.
Copy to Copy file to phone memory or miniSD Card.
Rename Rename clip.
Gallery downloads > Go to download link for images, videos, or sounds in Browser.
Receive via infrared Receive a file via infrared.
View details View clip details such as file format, size, resolution, and dura-

tion.
Add to Favourites Add a shortcut to view or listen to clip from Favourites.
Settings Adjust multimedia settings (see page 69).

Note: Gallery downloads and Receive via infrared features may not be available.

Play: Press Options and select Play. Video automatically begins 
playing when first opened.

Stop: Press Stop softkey.
Pause: Press Pause softkey or press . To resume play, press  

and select Continue, or press Options and select Continue.
Fast forward: Press and hold  on navigation key during play.
Fast rewind: Press and hold  on navigation key during play.

Play: Pause: Rewind:

Stop: Fast forward: Record:
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2. Phone icon tab shows data stored in phone memory, or scroll  to view data stored 
on miniSD Card. 

3. Open respective folder, then highlight desired file.
4. Press Options and select Send > Via multimedia, Via e-mail, Via Bluetooth or 

Via infrared.
5. To complete multimedia messages, see page 42; or E-mail messages on page 44; 

or Bluetooth on page 82; or Infrared on page 84. 

DOWNLOAD PICTURES, VIDEO AND SOUND CLIPS
From Media application:
1. Open Gallery.
2. Press Options and select Gallery downloads > Graphic downloads, Video 

downloads, or Tone downloads.
3. The Browser opens. Choose a bookmark site to download the desired media.

IMAGE UPLOADER
Store your personal pictures on an image server and share them with family and friends. 
To use this service, (1) you must purchase this service from your wireless service 
provider if it is available (2) you must configure an Internet Access Point.

Contact your wireless service provider to obtain the image server settings. Enter the 
image server settings in the phone (see page 65). 

Set Up Image Server
From Media application:
1. Open Gallery.
2. Scroll to an image to highlight it.
3. Press Options and select Image uploader > Settings.
4. Open Image servers. For the first time, select Yes to define an image server.
5. Open each field to enter information: 

Note: The Send option is not available for streaming media.

Note: Free content is available for your X700 phone. For downloading information, visit 
www.panasonicbox.com. Availability of this service is dependent on your country/
region or network. The downloaded content is free, however there will be a 
communication fee to download.

Note: Image Uploader service can support only JPG format files.

Image server name Enter a descriptive name for the image server
* Access point in use Choose desired access point from list. See page 95.
User name Enter your user name for the uploader service
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To edit or add more image servers, press Options and select Edit or New image 
server after opening Image servers. You can also delete image servers here.
To change the image server in use if you have set up more than one, open Image 
server in use setting and select desired image server.

Upload Images
To upload images to an image uploader service, from Media application:
1. Open Gallery.
2. Scroll to the desired image to upload to highlight it.
3. Press Options and select Image uploader > Upload.   

PHOTOBASE
Take pictures, then show them to your friends in a slide show right from your phone. 
Remove red eye, crop, rotate, or change brightness and contrast of your pictures before 
sharing them. You can also add frames, clip art, and text to your pictures. 

TAKE A PICTURE USING PHOTOBASE
From Media application:
1. Open PhotoBase.
2. Open Camera. 
3. With the flip open, the main display acts as a viewfinder. Move the phone around to 

frame your subject.
4. Press , or press Options and select Snap to take a picture.
The image appears on the display.
To keep the picture in your album, press Keep. 
To delete the picture, press Discard.

Before Taking a Picture
To change the zoom, scroll  or . To change contrast and brightness, scroll  or .

Password Enter your password for the uploader service
* Web address Enter the web address of the image server
Auto folder naming Select On to have the current time and date as the default name 

for your folders on the server

Note: For customer support and more information on PhotoBase, 
visit www.arcsoft.com.
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Before taking a picture, if desired, press Options and select:

VIEW PHOTOS
From Media application:
1. Open PhotoBase.
2. Open Album. 
3. Scroll to desired photo and open.
• To zoom in or out, press Options and select Zoom In or Zoom Out. Scroll , , , 

or  to pan in zoomed images.
• Scroll  to view previous photo, scroll  to view next photo.

Slide Show
To see a slide show of the photos in your Images folder, from Media application:
1. Open PhotoBase.
2. Open Album. 
3. Press Options and select Slide show.
4. Select a time interval between slides, and select a transition effect, for example, Top 

to Bottom, to apply as each slide advances to the next.
5. Press Play. 
6. Press  to exit.

EDIT PHOTOS
From Media application:
1. Open PhotoBase.
2. Open Album. 
3. Scroll to highlight desired photo and open.
4. Press Options and select Edit.
5. Press Options and select:

Mode > Choose Frame to add a frame to the picture. Horizontal Pan-
orama and Vertical Panorama allow you to stitch 3 pictures 
together.

Picture folder > Choose the memory to store your pictures. Customize allows 
you to create a new folder. 

Settings Configure camera settings.
Go to Album Go to your Album.

Save Save edited photo in place of original photo.
Save as Enter a new name for edited photo and save as a new file.
Send > Send photo Via e-mail, Via Bluetooth, Via infrared, or Via 

MMS (multimedia).
Rotate left Rotate photo to left.
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Crop Photos
1. With opened photo on screen, press Options and select Edit.
2. Press Options and select Crop.
3. A dotted cropping box appears. Press  to resize the cropping box. Scroll  to 

make the cropping box taller, scroll  to shorten the box. Scroll  to widen the box, 
scroll  to narrow the box size.

4. To move the cropping box within the photo, press Options and select Move. Scroll 
as desired to move the cropping box.
• If you have moved the box, select Resize to adjust the box size again.

5. To apply the crop, press Options and select Crop it.
6. To save the cropped photo as a new photo, press Options and select Save as. 

Enter a name for the new photo.

ADD CLIP ART, FRAMES TO PHOTOS
1. With opened photo on screen, scroll  to go to Workshop screen.
2. Select Clip Art to add clip art or Frame to add frames.
3. Scroll to desired clip art or frame and select.
4. Once the clip art or frame appears on the photo, press Options and select:

5. Press Options and select Send for sending options.

Warp Photos
1. With opened photo on screen, scroll  to go to Workshop screen.
2. Select Warp.
3. A black crosshair mark appears on the photo. Scroll , ,  or  to desired spot 

where the warp will start. Press  to change the mark to red, then scroll in direction 
you want the warp to go.
• To add more warp points, press  as needed to toggle the mark between black 

and red.
4. Press Options and select Save, Save as, or Send for desired option.

Rotate right Rotate photo to right.
Brightness&
Contrast

Scroll  or  to adjust brightness, scroll  or  to adjust con-
trast.

Remove red eye Removes red eye from the photo.
Crop See Crop Photos on page 68.
Resize Resize photo by 200% or by 50%.

Move Scroll , ,  or  
Resize Scroll ,  to increase, ,  to decrease
Rotate Scroll ,  to rotate left, ,  to rotate right
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Add Text to Photos
1. With opened photo on screen, scroll  twice to go to Add Text tab.
2. Press Options and select Add new line. Enter text as desired. To edit text, press 

Options and select Edit current line, Delete current line, Change text color, 
Change text size, and Edit previous/next line. 

3. Press Options and select Save, Save as, or Send for desired option.

REALONE PLAYER
RealOne Player is a media player that plays your video clips, sound clips and streaming 
media links (web addresses) stored in the phone memory or miniSD Card. Video and 
sound clips attached to messages are automatically played by RealOne Player, without 
having to open the player first. Opening clips from Media Gallery, File Manager, 
Browser, and Favourites applications launches the RealOne Player.

See Specifications on page 134 for supported media file formats.

PLAY VIDEO CLIPS AND STREAMING MEDIA
From Media application:
1. Open RealOne.
2. Press Options and select Open > Most recent clips for the last several opened 

media files, or Saved clip to locate existing files and links in the phone memory or 
miniSD Card.

3. Open desired folder(s), then scroll to and open desired video or sound clip. When 
choosing a link to streaming media, the phone begins connection process to the 
Internet or to your network.
• See Player Controls on page 64.

REALONE PLAYER SETTINGS
View and adjust settings for video playback and streaming media links.
From Media application:
1. Open RealOne.
2. Press Options and select Settings. 
3. Highlight Video and open.
4. Select from: 

Note: For streaming media, after the phone successfully connects to the 
link (web address of streaming media), there is a short loading 
period to prepare playback, then the streaming media begins 
playing. See Player Controls on page 64.

Contrast Open, then scroll  or  to change the percentage.
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To view and adjust streaming media settings, from Media application:
1. Open RealOne.
2. Press Options and select Settings. 
3. Scroll to Connection and open.
4. Select Proxy and select No or Yes.

• If you select Yes, then scroll down and enter the Proxy serv. address and the 
Proxy port number.

5. Press Back and scroll to select Network. Open Network and select from: 

Incoming Call when Playing Video
If there is an incoming call during playback of video clips, the player pauses the video. It 
remains paused in the background during calls. To resume play, return to opened file 
and press Options and select Continue. 
The player also pauses when an alarm sounds, or a note appears, or you open another 
application. When you return to the player, press Options and select Continue. 
If you open an application when streaming video is playing, the streaming video pauses, 
and stops when the auto disconnect time period is reached. See RealOne Player 
Settings on page 69.

Repeat Select On to repeat playback, or select Off to playback one time.

Default access point Choose one of the access points you have set up. See Access 
Point Settings on page 95.

Online time Select Unlimited, or select User defined to specify the amount 
of time before phone will disconnect if there has been no activity.

Maximum bandwidth Select a maximum bandwidth for streaming media to use.
Connection time-out Select a maximum time period to wait from selecting a streaming 

link until it connects to the server. Scroll left and right to move 
the slider and change the time period.

Server time-out Select a maximum time period to wait for the media server to 
begin sending the streaming media. Scroll left and right to move 
the slider and change the time period.

Lowest UDP port Type in a User Datagram Protocol port number.
Highest UDP port Type in a User Datagram Protocol port number.
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VIDEO RECORDER
Record video clips to send to others, or play clips on your phone.

RECORD A VIDEO CLIP
To record nearby sound with the video, see Video Recorder Settings on page 72.
From Media application:
1. Open Video Recorder.
2. The main display acts as a viewfinder. Move the phone around to frame your 

subject.
3. Press Options and select Record to begin recording. Watch the screen, then move 

the phone as needed to keep the scene in view.
• Scroll  to zoom in, scroll  to zoom out if zoomed in.
• Press Pause to pause recording, press Resume to resume recording.

4. The video recorder records until reaching the clip size limit (specified in File Duration 
in Settings), or until you press Stop softkey. 

5. Wait for a few seconds while the video clip is saved to Media Gallery Videos folder, 
or the miniSD Card according to Video storage setting. The last still image of the 
recording remains on screen.

To send the video clip immediately, see Send a Video Clip on page 71. 

If you do not want to save it, press  and select Yes, or press Options and select 
Delete.

SEND A VIDEO CLIP
1. With the video clip on screen, press , or press Options and select Send > Via 

multimedia, Via e-mail, Via Bluetooth, or Via infrared.
2. To complete Multimedia messages, see page 42; or E-mail messages on page 44; 

or Bluetooth on page 82; or Infrared on page 84. 

Play a Video Clip
To play the video clip that was just recorded, press Options and select Play.

Note: Video Recorder mode depletes battery power more rapidly. To conserve 
your battery, the phone shifts to standby mode after 40 seconds if 
recording has not started. Press Options and select Continue to return to 
viewfinder mode. 

Note: The quality of display images may vary depending on the 
object or environment.
Display images may distort when shooting moving objects, 
especially in a fast moving environment. 
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To play a stored video clip, from Media application:
1. Open Video Recorder.
2. Press Options and select Video Album.
3. Continue with step 3 in Play Video, Sound Clips, and Streaming Media on page 63.

VIDEO RECORDER SETTINGS
From Media application:
1. Open Video Recorder.
2. Press Options and select Settings.
3. Select from: 

PhotoLight
Light up your subject before recording a video clip. See PhotoLight on page 119. 

Incoming Calls when in Video Recorder Mode
If you receive a call while in video recorder mode, video recording stops and the video 
clip is saved. After the calls ends, the last image of the recorded clip displays. 

Resolution Choose the size of the display on the screen to be Low or High.
Audio recording Set to On to capture nearby sound as you record. Off turns off 

the microphone.
Video name base Enter desired text. For example, if you change the name to 

SkiTrip, then your video clips will be named SkiTrip; SkiTrip(01); 
SkiTrip(02), etc. until the default name is changed.

Video storage Choose whether video clips are stored in phone memory or on 
miniSD Card.

File Duration Choose a fixed size for recorded clips, or unlimited size.
Video quality Choose Low or High. 
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CONNECTIVITY
Browse the Internet. View and manage your phone’s connections to other devices that 
can be connected to the phone, wirelessly and by cables. Synchronise your Contacts 
and Calendar entries with your other networked devices. Your network, Internet, e-mail 
service providers can help you configure and manage your connection settings using 
Device Manager. View your active connections using Connection Manager.

Connectivity menu contains these main options:

BROWSER
Your phone has an XHTML configured wireless Internet browser, allowing you access to 
services such as news, weather reports, banking, sports, travel information and stock 
quotes.

Wireless web sites are designed to be viewed on mobile phone screens, so they consist 
mostly of text and may contain simple graphics. Wireless sites are written in Wireless 
Markup Language (WML) and XHTML (Extensible Hypertext Markup Language), which 
is different than Hypertext Markup Language (HTML) used in computer Internet 
websites and cannot be accessed by wireless phones.

Your phone browser can access WAP 2.0 sites and download games, sound, software, 
WBMP images, vCard and vCalendar events and more.

Types of Data Connections
GPRS and data call (CSD) data bearer technologies are used to access the Internet.

GPRS is General Packet Radio Service, a packet based high speed data transfer 
technology that allows continuous connection, in which many users share a connection 
and packets are transferred only as needed.

Data call, or CSD, is Circuit Switched Data, which uses a dedicated connection much 
like ordinary voice phone service. 

Browser Operator Modem

Bluetooth Infrared USB

Conn Mgr SyncML Dev Mgr

Note: The types of services and content offered when connected to the 
Browser are supplied entirely by your wireless service provider.
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SETUP TO CONNECT TO BROWSER
Before starting; (1) you need a subscription for data services from your wireless service 
provider and (2) you must configure an Internet Access Point. 
Your wireless service provider may have already completed the Internet Access Point 
connection settings, or sent them to you in a message. Contact your wireless service 
provider to find out how setup information is furnished.
If you are setting up the Internet Access Point, see page 95.

CONNECT TO THE INTERNET
There are two main ways to store shortcuts to wireless Internet sites. (1) Bookmark list 

 stores web addresses that you or your wireless service provider saved to the list. 
(2) Saved Pages list  stores actual WAP pages that you can view online or offline.

From Connectivity application:
1. Open Browser.
2. A list of Internet Access Points and bookmarks appears, and folders may appear. 

Your wireless service provider may have loaded links to their services that appear 
as bookmarks. Scroll to the desired connection or bookmark and select.
• You can also scroll  for the Saved pages list , which stores WAP pages 

that you can view offline, and launch to refresh pages.
3. The phone begins connection process.

NAVIGATE THE INTERNET
In general, when connected to the Internet through the Browser:  

Shortcut: Press  to launch Browser.

Note: Your wireless service provider may have set your phone to go to 
the Home page for their services when you launch Browser.

Scroll up , down , left  or right  by pressing outer edges of 
navigation key through the page content.
Select a highlighted item or launch an underlined web page.
Press and hold to open Bookmarks list.
Erase character.

Back - Go backward in navigation history.
Close - Go to Bookmarks or Saved pages view.
Cancel - Ends current download.
Press and hold to disconnect the Browser at any time.

Indicates secure online browsing connection.
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Secure Connections
A secure connection means that the connection to transmit data between the phone and 
the network server has been secured and encrypted. Your wireless service provider is 
responsible for securing the connection between the network server and Internet sites.

Ask your wireless service provider for details of their secure connection capabilities. 
Proceed with caution when downloading files and content or entering sensitive 
information.

Online Options
During an Internet connection, you can add and refresh bookmarks, reload pages, and 
view active session details.

Press Options and select:

Note: If you go to a site with many graphics, it may take longer for the images to load. 
To stop images from loading, see Show images setting on page 77.

Open Open highlighted link.
Accept Accept your text entry to the current page.
Service options > Open a list of commands or actions for the page.
Bookmarks View Bookmarks list.
Save as bookmark Save the web address to your Bookmarks.
View image If there are images on the page, open a list of images. To view a 

specific image, scroll to the image and press OK.
Navigation options > Go to web address, History to select a previously viewed page 

during current session, Clear cache to delete content in cache 
memory, Reload to update current page.

Advanced options > Original screen to fit page into the display of your phone, Save 
page to save current page to Saved pages list, Disconnect to 
end connection.

Show images Appears if you have set the Show images setting to No in the 
Browser settings to allow the images on current page to load.

Send bookmark > Send current page via text message.
Find > Find phone number, e-mail address or web address on current 

page. Start typing for Find field to appear. 
Details View details and security of current session.
Settings See Browser Settings on page 77.
Service msg. Appears if you have unread WAP push messages.
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When online, you may have calling options from a current page. You can click on a link 
to book tickets or order gifts, for example. The link allows you to make a phone call 
directly from the browser. 

When viewing any Directory services an ‘Add to Contacts’ link may appear. Click on the 
link, and a new Contacts entry form displays. Save the entry to return to the browser.

Disconnect from Internet
To disconnect from the Internet, either press and hold , or press Options and select 
Disconnect.

BOOKMARK OPTIONS
Manage your bookmarks when offline or online.
From Connectivity application:
1. Open Browser.
2. Press Options and select:

DOWNLOAD FILES FROM THE INTERNET
You can download ringtones, games, video and sound clips, and applications to your 
phone through the Browser. After downloading, the files are saved to the relevant menu 
application in the phone.

From Connectivity application:
1. Open Browser.
2. Scroll to Download Applications, Download Images, Download Skins, 

Download Sounds, or Download Videos, and open.

Download Connect to selected bookmark.
Bookmark manager > Move to folder, New folder, Edit bookmark, Add bookmark, 

Delete.
Mark/Unmark > Select Mark or Mark all to perform actions to multiple items.
Navigation options > Go to web address or Clear cache.
Advanced options > Add to Favourites to add the bookmark to your Favourites 

shortcuts.
Send > Send web address to another device.
Find bookmark Type in one or two characters to go to bookmark titles beginning 

with that character
Settings See Browser Settings on page 77.

Note: This feature may not be available.
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3. Scroll to desired bookmark if there is more than one, then open the bookmark. The 
phone begins connection process.

4. After connecting to the site, scroll to desired hotlink containing the file and open.
5. After the file is downloaded, it is stored in the menu application in which the file is 

opened; for example, a video clip is stored in Gallery.  

BROWSER SETTINGS
Check your default access point, specify if you want images to be automatically loaded, 
and allow cookies to be stored on the phone.
From Connectivity application:
1. Open Browser.
2. Press Options and select Settings to reach:   

Note: Panasonic is not responsible for the performance of downloaded content 
or possible corruption of phone software.
The phone may not allow you to copy, modify, transfer or forward some 
copyrighted images, ringtones or other content.

Default access point Change default access point for connecting to the Internet 
through the Browser

Show images For faster Internet surfing, select No to stop images from auto-
matically loading. When online, press Options and select Show 
images on a specific page to load an image.

Font size Select a font size for web page text to appear
Default encoding For the Browser pages to display text characters correctly, select 

one from: S. Chin., West. Europ., T. Chinese, Unicode (UTF-8), 
Central Eur., Baltic, Cyrillic, Greek, Turkish, Heb. (ISO-Logical), 
Hebr. (ISO-Visual), Arabic (ISO), Arabic (Windows), Hebr. (Win-
dows), Cent. Eur. (Wind.), Cyrillic (Windows), Greek (Windows), 
Turkish (Wind.), Baltic (Windows) or Automatic.

Cookies Choose Allow to store cookies, which are short text files that a 
web server places on your phone for purposes such as present-
ing customised web pages to you.

Security warnings Choose Show or Hide for secure site notification
Conf. DTMF sending Select whether to First time only or Always before sending 

DTMF touch tones during a call when online.
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SAVED PAGES
Saved pages are web pages and folders you have stored on the phone to view offline. 
From Connectivity application:
1. Open Browser.
2. Scroll  to open the Saved pages tab .
3. Scroll to the desired page and select.
4. Press Options and select:

OPERATOR MENU
Your network operator may offer services that you can view using the Browser. Contact 
your network operator for availability and types of services offered.
From Connectivity application:
1. Open Operator.
2. In the page, press Options and select:

Open View saved page or open folder.
Back to page Return to page you visited before opening Saved pages.
Reload Download and store the latest version of the saved page.
Saved pages mngr. > Move to folder to move a saved page to a different folder, New 

folder, Rename or Delete.
Mark/Unmark > Select Mark or Mark all to perform actions to multiple items.
Navigation options > Clear cache to delete content in cache memory.
Advanced options > Add to Favourites to create shortcut to page from Favourites 

application.
Settings See Browser Settings on page 77. 

Open Open highlighted link.
Close browser Disconnect from your operator’s service pages.
Navigation options > Go to web address to go to new address, History to select a 

previously viewed page during current session, Reload to 
update current page.

Advanced options > Original screen to fit page into the display of your phone, Save 
page to save current page to Saved pages list, Disconnect to 
end connection.

Find > Find phone number, e-mail address or web address on current 
page. Start typing for Find field to appear. 

Details View details and security of current session.
Settings See Browser Settings on page 77.
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MODEM
You can link together your X700 phone as a modem to a computer or a PDA to access 
the Internet. 

Link your phone and computer to access the Internet
To use the X700 phone as a modem there are three options; connect using the infrared 
port, connect using Bluetooth, or connect using the Panasonic USB Data Cable (EB-
UCX71). See Accessories on page 132 for USB Data Cable information.

Prerequisites
• Set up a dial-up account with an Internet Service Provider (ISP).
• From your ISP, you need the installation CD or your account details (i.e. dial-up 

number, user name, password, DNS server addresses) to configure Dial Up 
Networking.

• When setting up your Internet account for the first time, select X700 as the 
connecting modem device. For more details, contact your ISP.  For help using 
Windows® Dial Up Networking, search Windows® Help files.

Install X700 as Modem on Computer
The following describes how to set up a computer to connect to your X700. The 
procedure described may differ for other software packages.

To install your phone as a modem on a computer, here is an example. On the computer, 
select Start > Settings > Control Panel > Modems > Add > Other > Don’t detect my 
modem > Standard 33600 bps modem > Communications Port > Virtual Com Port. For 
specific instructions on your computer’s operating system, refer to your computer’s on-
line help.

Set Up Connection
From Connectivity application:
1. Open Modem. 
2. Align the infrared port of your phone with the infrared port of the computer.
3. Select Connect via infrared, which opens the infrared connection.

• To use Bluetooth, you must start the Bluetooth connection from the computer or 
device to which you are connecting. To prepare your phone to connect via 
Bluetooth, see Set up Bluetooth on page 81. 

• To use USB data cable, you must start the connection from the computer or 
device to which you are connecting.

Note: This info may be on CD-ROM.

Note: If connecting with a data cable, select Com 1 in the Communications Port field.
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4. The phone confirms when a connection is established.
• If Bluetooth connection is successful, when you select Connect via infrared, the 

phone will state that the modem is already in use by Bluetooth.

Make Connection to Internet
1. Now you can create a new GPRS connection. For example, on the computer, select 

Start > Programs > Accessories > Communications > Dial-Up Networking > Make 
New Connection. For specific instructions, see your computer’s on-line help.

2. Enter X700 as the name you are dialling, and choose Standard 33600 bps Modem 
as the device then select Next. Choose 115200 as the Maximum speed. In the 
telephone number field,  enter *99# then click Finish.

3. You will now have an X700 connection icon in the computer’s connection screen. 
Double click the icon and select Connect to begin the connection. 

BLUETOOTH® WIRELESS TECHNOLOGY
Bluetooth wireless technology uses radio waves to communicate with other Bluetooth 
devices within a maximum range of 10 metres. You can send and receive business 
cards, pictures, Calendar events, video and sound clips, and other data between 
Bluetooth devices such as mobile phones and computers. 

Use a Bluetooth headset to talk wirelessly on your phone whilst the phone is in your 
pocket or purse. 

This phone supports Bluetooth v1.1 connectivity with the following profiles:  Serial port, 
Dial-up networking, Object push, File transfer, Headset, and Handsfree.  

Note: To close the connection, press Disconn. softkey. If there is 
an on-going data call, the call is ended first.

Note: Although Bluetooth devices can connect within a 10 metre range, walls or 
other nearby barriers may cause interference.
Check with local authorities before using Bluetooth wireless technology 
as some countries may restrict the use of Bluetooth devices.

Battery note: Keeping Bluetooth setting “On” consumes battery power more 
rapidly. To conserve battery power, switch off Bluetooth setting 
when not in use. Switch Bluetooth on or off in Settings.

X700_OI.book  Page 80  Wednesday, September 1, 2004  6:47 PM



   81

SET UP BLUETOOTH
You must first set up Bluetooth connections before using it for the 
first time. Thereafter, go to the Settings tab to switch Bluetooth 
setting on or off and change your phone’s visibility to other Bluetooth 
devices.
From Connectivity application:
1. Open Bluetooth.

2. In the Settings tab, open fields:   

PAIR WITH OTHER DEVICE AND CONNECT
From Connectivity application:
1. Open Bluetooth.
2. Scroll  to Paired devices tab.
3. Ensure that the device in which you want to pair is switched on, and its Bluetooth 

setting is activated.
4. Press Options and select New paired device. If Bluetooth setting is switched off, 

press Yes to switch on Bluetooth setting. 
5. The phone begins searching for devices and notifies you when it finds the other 

device.
6. Press Select. Enter the passcode for the connecting device if needed and press 

OK. If the other device has not yet been paired, first decide on a passcode with the 
other person, then enter it when requested, press OK.

7. To connect with the device, open the device name and select Connect.

Bluetooth Select On or Off.
My phone’s visibility Choose Shown to all to allow other Bluetooth devices to find 

your phone when searching, or select Hidden to keep other 
Bluetooth devices from finding it during a search.

Visibility Timeout Choose Disabled to keep My phone’s visibility setting as 
Shown to all, or scroll to select a time period after which your 
phone cannot be found by other Bluetooth devices (My phone’s 
visibility setting changes to Hidden).

My phone’s name Use the default name or enter a name for your phone that other 
devices will see when they search for your phone.

My Transfer Speed Choose Normal, Fast, or Very Fast.

Note: The passcode may be stated in the connecting device user guide.
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SEND AND RECEIVE DATA VIA BLUETOOTH
You can send and receive Contacts cards as business cards, Calendar events, pictures, 
video and sound clips, bookmarks, configuration messages, and receive applications 
supported by the phone via Bluetooth.

To send data via Bluetooth:
1. Ensure that the device in which you want to pair is switched on, and its Bluetooth 

setting is activated. On your phone, go to the application menu that contains the 
data you wish to send, for example, go to Contacts to send a business card.

2. Highlight the desired item to send.
3. Press Options and select Send > Via Bluetooth. If Bluetooth setting is switched 

off, press Yes to switch on Bluetooth setting.
4. The phone automatically searches for Bluetooth devices nearby.

• Devices appear one-by-one. If device has already been paired,  icon appears 
with device name. Press Stop to stop search when intended device name pops 
up.

• If the other device has not yet been paired, first decide on a passcode with the 
other user, then enter it when requested, press OK. 

5. Scroll to the intended device and select. Connecting message appears, then when 
other device accepts, a confirmation message displays when transfer is complete.
• If the other device does not accept the data, Bluetooth connection cannot send 

the data. 

To receive data via Bluetooth:
1. Press Show to accept the incoming message containing the data. (If phone is not in 

standby mode, Show does not appear.) The message is placed in the Inbox in 
Messages.

2. Open the message, press Options and select Save to save data to phone memory 
or miniSD Card. You can rename the file.

MANAGE PAIRED DEVICES
From Connectivity application:
1. Open Bluetooth.
2. Scroll  to Paired devices tab and scroll to desired device.
3. Press Options and select: 

Note: The phone may not allow you to copy, modify, transfer or forward 
some copyrighted images, ringtones or other content.

Note: Confirmation is required first if the paired device is not set as authorised.

New paired device Search for nearby Bluetooth devices.
Assign short name Change name of paired device to an easily recognised name.
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Icons of paired devices   

INFRARED
Transfer data between your phone and other infrared enabled devices using an infrared 
wavelength connection. You can also use infrared connections for GSM data services, 
and access the Internet and e-mail via other devices.  

PREPARE FOR INFRARED CONNECTION
Place your phone and the other device within the effective range of the infrared 
connection, about 20 cm.
• Verify there are no obstructions between the two devices.
• Ensure that the infrared ports of the devices point at each other.
• On the receiving device, activate the Infrared port.
• If the other device is a computer, you need to set up infrared connection on the 

computer. For example, in Windows, select Start > Settings > Control Panel > 
Options tab > Enable Infrared Communication. For specific infrared set up 
instructions for your computer’s operating system, refer to the computer’s on-line 
help.

Set as authorised or 
Set as unauthorised

Allow automatic connection without manually accepting each 
time, shown by  icon. Unauthorised setting requires confirma-
tion each time the device attempts to connect to the phone.

Delete Delete the paired device from your list.
Delete all Delete all paired devices.

audio computer phone miscellaneous

Note: Multiple devices can be paired; however, only one active connection 
is possible at any given time.

Note: The phone may not allow you to copy, modify, transfer or forward 
some copyrighted images, ringtones or other content.

Caution: This device contains a low power level Class 1 laser product 
(Infrared LED), which will not normally harm the eyes. Though 
invisible to the eye, do not point the infrared beam at anyone’s 
eye. Nearby activated infrared devices may cause interference.

Note: For Windows® 2000 users, to enable infrared use to transfer files, 
go to Start > Settings > Control Panel > Wireless Link. In the File 
Transfer tab, check ‘Allow others to send files to your computer 
using infrared communications’. 
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SEND AND RECEIVE DATA VIA INFRARED
You can send and receive Contacts cards as business cards, Calendar events, pictures, 
sound clips, bookmarks, configuration messages via infrared, and receive applications 
supported by the phone.
To send data via Infrared:
1. Prepare for infrared connection as described on page 83.
2. Go to the application menu that contains the data you wish to send, for example, go 

to Contacts to send a business card.
3. Open the item you wish to send.
4. Press Options and select Send > Via infrared.
5. The phone automatically begins infrared connection, indicated by flashing . 

Whilst transferring, icon is steady. A confirmation message displays when complete.

To receive data via Infrared:
1. Prepare for infrared connection as described on page 83.
2. From Connectivity application, open Infrared.
3. Flashing icon  displays, meaning phone is ready to receive data. 
4. Sender can begin transfer of data. A tone sounds when transfer is complete.
5. Press Show to accept the incoming message containing the data. The message is 

placed in the Inbox.
6. Open the message, press Options and select Save to save data to supporting 

application. You can rename the file.
• If transfer does not begin within 40 seconds, the infrared connection 

automatically stops.

USB
Connect to PC Software Suite over your USB cable using USB application.

CONNECT TO PC SOFTWARE SUITE
1. Plug in USB cable into the phone.
2. From the Connectivity application, open USB.
3. USB icon appears indicating that USB connectivity has started.
4. On your computer, begin desired task such as backup or sync.

CONNECT TO MODEM
1. Plug in USB cable into the phone.
2. From the Connectivity application, open Modem.
3. Select Connect via USB.
4. USB icon appears indicating that USB connectivity has started.
5. On your computer, start a connection using the phone as a modem.
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CONNECTION MANAGER
View status, speed, and amount of data transferred for all of your currently active GPRS 
and Data call network connections.

VIEW CONNECTION DETAILS
From Connectivity application:
1. Open Conn Mgr.
2. A list of currently active network connections appears, sorted according to starting 

time of connection.
3. Scroll to desired connection, press Options and select Details to view name, bearer 

(GPRS, data call), status (creating connection, idle, active, on hold, closing 
connection or closed), received and sent data amount in bytes, duration, downlink 
and uplink transfer speed in kb/sec, dial-up number (data call only), GPRS access 
point name (GPRS only), sharing.

END CONNECTIONS
From Connectivity application:
1. Open Conn Mgr.
2. A list of currently active network connections appears, sorted according to starting 

time of connection.
3. To end one connection, scroll to desired connection, press Options and select 

Disconnect.
To end all active connections, press Options and select Disconnect all.
• If you are ending all connections, the Data call connections are closed first, then 

the GPRS connections close in the same order as established.

SYNCHRONISATION
Set up profiles and synchronise your Contacts and Agenda (Calendar) entries with your 
other networked devices.

CREATE A NEW SYNC PROFILE
From Connectivity application:
1. Open SyncML.
2. If there are no profiles, select Yes to create a new profile. Or, press Options and 

select New sync profile, press Yes.

Note: GPRS connection cannot be closed if it is currently 
suspended due to circuit-switched activity.
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3. Enter information in fields. Fields marked in the phone with a red asterisk (*) must 
have an entry. 

4. Next, scroll  to move to Content tab.
5. For each field, press Options and select Change, select Yes.
6. Open Remote database and enter location on the network of each of the 

databases.
7. Open Synchronisation type and choose if you want to synchronise in both 

directions (Normal), from server to phone (To server only), or from phone to server 
(To phone only) for each database.

SYNCHRONISE
If you are synchronising from the server to the phone, you will receive a message in the 
Messages Inbox. When you open the message, you are asked if you wish the server to 
begin the synchronisation process. If you accept, the process automatically begins.
To begin synchronising from the phone, from Connectivity application:
1. Open SyncML.
2. Highlight desired profile, press Options and select Synchronise.

During synchronisation from either direction, you can follow the process on the phone. 
The phone confirms completion.

To cancel synchronisation, press Cancel.
If synchronisation fails, for example, the sync server is busy or the database cannot be 
opened, you are notified of the error type.

VIEW OR EDIT SYNC PROFILES AND CONTENT
From Connectivity application:
1. Open SyncML.
2. Highlight desired profile, press Options and select Edit sync profile.
3. Scroll to desired fields to view and open to edit.

If a profile has been synchronised, press Options and select View log to view profile 
name; remote server name; date, time, and status of last synchronisation, and details of 
content transfer.

* Sync profile name Enter a name if not assigned.
Access point Select desired access point name.
* Host address Enter web address of sync server.
Port Enter port number of sync server.
User name Type your user name for the server.
Password Type in password.
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To view or edit the Content settings, scroll  to view the Content tab and continue with 
step 6 in Create a New Sync Profile on page 85.

DEVICE MANAGER
Your network, Internet, e-mail service providers can help you configure and manage 
your connection settings. These settings can be sent to your phone over the air. Device 
Manager menu allows service providers to configure and update these settings from 
their servers on your behalf. Settings may include network access points, multimedia, e-
mail, and synchronisation connections.

CONFIGURATION SESSION
A configuration session can be started either from the Device Manager application in the 
phone, or from the service provider’s server.

If your service provider intends to start a session, your phone will show a server alert 
message. Before the session can begin, your phone asks to activate the server 
connection and the profile if they are off. Then the phone asks you to accept that the 
server is ready to configure. If you don’t want the session to run, press Reject or 
Cancel.

Once the configuration session begins, the phone displays status notes advising the 
session stage: connecting to the server, receiving data from the server, processing data, 
and disconnection.
To start a configuration session yourself (if server profile is set up), from Connectivity 
application:
1. Open Dev Mgr.
2. Scroll to desired server profile in which you wish to start configuration session.
3. Press Options and select Start.

CREATE A NEW SERVER PROFILE
The server profile is the settings needed to connect your phone to a service provider’s 
device management server, which handles the configuration session procedure.
From Connectivity application:
1. Open Dev Mgr.
2. If there are no profiles, select Yes to create a new profile. Or, press Options and 

select New server profile.

Note: If you set the server profile to accept configuration sessions 
without verification, then the session will begin in the background. 
View the process by opening Device Manager application.
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3. Enter information in fields. Fields marked in the phone with a red asterisk (*) must 
have an entry. 

VIEW OR EDIT SERVER PROFILES
From Connectivity application:
1. Open Dev Mgr.
2. Scroll to desired server profile, press Options and select Edit profile, or Delete.

View Session Log
To view the results of a selected server’s last configuration session, from Connectivity 
application:
1. Open Dev Mgr.
2. Scroll to desired profile, press Options and select View log.

The log shows name of server configured, results of configuration, date and time, and 
errors if any occurred during configuration.

SHORTCUT TO STOP CONFIGURATION SESSIONS
There may be times in which you do not want configuration sessions to run. Instead of 
going to each server profile to set Active to not allow device management to be done by 
the server, you can set the phone so that device management cannot be done by any 
server.

The default setting is to allow device management to be done (Enable configurations).

* Server name Use suggested name or enter your own. 
* Server ID Server’s unique ID identifies the remote server.
Server password Server password supplied by service provider so your phone 

can verify server.
Access point Select desired access point.
* Host address Server’s web address.
Port Server’s port number.
* User name Type in your user name for the server.
Password Device Manager password supplied by service provider so the 

server can verify your phone.
Allow configuration Select Yes to allow device management to be done by this 

server.
Accepted Select Yes to allow device management to be done by this 

server without Accept command.
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From Connectivity application:
1. Open Dev Mgr.
2. Press Options and select Disable config..

• All server profiles are disabled and no configurations can be done.
To allow configurations to be done again, press Options and select Enable config..
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SETTINGS
Choose your ringtone and theme settings here. Configure your phone, call, connection, 
security, call divert, barring, GSM network, and accessory settings. Set the clock, 
alarms, and speed dial shortcuts.

Settings menu contains these main options:

RINGTONES
Ringtone profiles are unique ringing tone, alert tones, and volume settings used to alert 
you to calls and messages. Choose from General, Silent, Meeting, Outdoor, and 
Pager. Each can be modified to suit your situation. You can use ringtones sent in a 
message, sent by Bluetooth or infrared connections, recorded with the Recorder 
application, or downloaded. 

The active ringtone name is displayed in the standby screen, except when General is 
active.

ACTIVATE A RINGTONE
From Settings application:
1. Open Ringtones.
2. Scroll to the desired ringtone.
3. Press Options and select Activate. 

CHANGE RINGTONES, ALERT TONES AND VOLUME
You can change, or personalise, individual settings within a ringtone. For example, in 
General ringtone, change the ringing tone to a ringing tone you downloaded.

From Settings application:
1. Open Ringtones.
2. Scroll to the desired ringtone.
3. Press Options and select Personalise. 

Ringtones Themes Settings

Clock SpeedDial Voice

PB Setup About

Note: Free content is available for your X700 phone. For downloading information, visit 
www.panasonicbox.com. Availability of this service is dependent on your country/
region or network. The downloaded content is free, however there will be a 
communication fee to download.
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4. Scroll to the desired setting:    

Ringing and Alert Tone Volume
Ringing and alert tones play only when the phone’s current ringtone is General or 
Outdoor. The other ringtones mute playing of ringing tones.
To change the volume of tones when scrolling through the list, go to the Ringing 
volume field and adjust volume. 

THEMES
Change the visual look of your phone screens without changing the way the phone 
works by using Themes. Themes are wallpapers, text and icon colours and sets 
packaged in a theme. Themes, or skins, are preinstalled when you purchase your 
phone, or you can download and install them yourself.

PREVIEW THEMES
From Settings application:
1. Open Themes.
2. Scroll to the desired theme name.
3. Press Options and select Preview.

Ringing tone Scroll through list of tones. To hear the tone, highlight the tone 
name and wait. To stop the tone, press any key. To select a tone, 
highlight the tone name and press Select. If you have sub-
scribed to 2 lines, then a setting appears for each line.

Ringing type Choose Ringing, Ascending, Ring once, Beep once, or 
Silent.

Ringing volume Scroll  to move the volume bars.
Message alert tone Same as Line 1 ringing tone.
Vibrating alert Select On or Off.
Keypad tones Select Off, Level 1, Level 2, or Level 3.
Warning tones Select On or Off.
Alert for If you have set up Contacts groups, select the desired group 

name if you want the phone to ring only when members of that 
group call. Other incoming calls will have the silent alert.

Profile name Change the name of any ringtone except General.

Note: Free content is available for your X700 phone. For downloading information, visit 
www.panasonicbox.com. Availability of this service is dependent on your country/
region or network. The downloaded content is free, however there will be a 
communication fee to download.

X700_OI.book  Page 91  Wednesday, September 1, 2004  6:47 PM



92      

ACTIVATE A THEME
From Settings application:
1. Open Themes.
2. Scroll to the desired theme name.
3. Press Options and select Apply.

• When previewing, press Apply to activate the theme.

CHANGE WALLPAPER OR SCREENSAVER
Change the background image of the standby screen or Favourites screen, the colour of 
bars and frame boxes, and the screensaver.
From Settings application:
1. Open Themes.
2. Press Options and select Edit; or to edit a specific theme, first scroll to desired 

theme before pressing Options:    

DOWNLOAD NEW THEMES
You can download themes directly from predetermined web sites without first going to 
the Browser application. These links are set by agreements with content providers who 
offer the themes. 
From Settings application:
1. Open Themes.
2. Press Options and select Theme downloads.
3. A folder displays, containing links to content provider web pages.  

• You can add your own links to the folder.
4. Open the folder and scroll to and open desired link.

Note: The appearance of some icons may change when you apply a different theme.

Idle state wallpaper Idle screen. Choose from Default, User defined (your own 
image from Gallery or downloaded), other themes, or None.

Colour palette Choose from the default colour or other listed colours for com-
mon bars, icons, and frames.

Screen saver Choose Date and time(Default), or Text (write your own text 
message).

Icons Choose from a list of theme set of icons.
Favourites wallpaper Favourites. Choose from Default, User defined (your own 

image from Gallery or downloaded), other themes, or None.

Note: When the copy option appears, you can copy themes from 
the phone memory to the miniSD Card or in reverse.
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5. Connection to the Browser will begin.

SETTINGS
In the Settings menu, you can configure your phone, call, connection, date and time, 
security, call divert, barring, GSM network, and accessory settings.

PHONE SETTINGS
Set the phone language, writing language, and welcome note or 
logo here.  
From Settings application:
1. Open Settings.
2. Open Phone.

3. With General highlighted, open to select: 

Display Settings
Adjust the brightness of the display screen and set a screen saver timeout.
From Settings application:
1. Open Settings.

Note: Some links may be preset by content providers and cannot be deleted.

Phone language Choose a language in which the texts on the displays will 
appear. Automatic uses the language dictated by the SIM card.

Writing language Choose a language in which the texts you are writing will 
appear, for example, writing a text message.

Dictionary Select On to use the predictive text dictionary to speed up text 
entry.

Welcome note or 
logo

Default uses the welcome note or image supplied with the 
phone, displayed when the phone is switched on. Select Text to 
enter your own welcome note. Select Image to place an image 
from Media Gallery.

Shutdown animation Select Off to stop the animation shown after switching off the 
phone.

Keypad backlight 
time

To save battery life, select Always off for the keypad backlight 
to remain off.

Orig. phone settings Used if a network operator used settings protection in a phone, 
and later there is a reason to change the protected settings. 
Requires lock code.
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2. Open Phone.
3. Scroll to Display and open. Select and open:

Standby Mode Settings
Choose an application name to display on the left and on the right softkey in standby 
mode to use as shortcuts to the respective applications.
From Settings application:
1. Open Settings.
2. Open Phone.
3. Scroll to Standby mode and open. Select and open:

Left selection key Scroll to desired application, press OK.
Right selection key Scroll to desired application, press OK.

CALL SETTINGS
From Settings application:
1. Open Settings.
2. Scroll to Call and open.
3. Scroll to:

Brightness Scroll  to lighten the screen, or scroll  to darken the screen, 
then press OK.

Screen saver timeout Scroll  or  to choose from 1 minute to 30 minutes of no 
activity until screen saver switches on and press OK.

Send my caller ID Choose Set by network, Yes or No. Determines if your mobile 
number is presented to the person you are calling. Network 
dependent.

Call waiting Press Options and select Check status. If needed, select Acti-
vate. Network will send confirmation message. When activated, 
if you are on a call and there is an incoming call, you can put the 
first call on hold and answer the second call. See Call Waiting on 
page 20.

Automatic redial Select On to redial if the call is not connecting. Press  to stop 
automatic redialling.

Summary after call Select On to display a brief summary of duration of last call.
Speed dialling Select On to start dialling by a press and hold of preset number 

key in standby mode. First, set up Speed dial keys in Settings 
(see Speed Dial on page 105). 

Anykey answer Select On to answer incoming calls by pressing any key except 
, , or .
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CONNECTION SETTINGS
Access Point Settings
Access points are sets of configurations that connect your phone to the Internet and 
other services. Your phone uses three main sets of access points: Multimedia (MMS), 
Browser, and Internet. Access points must be set up in order to send and receive 
multimedia and e-mail messages, use the Browser, use SyncML, use Device Manager, 
use your phone as a modem, and download.

Access points use data services to connect. Types of data services your phone can 
support are: Data call (Circuit switched data) and GPRS (Packet data). Contact your 
wireless service provider to find out about types of data technologies offered and 
subscription rates.

Some or all of your access points may be preset in the phone by your wireless service 
provider and cannot be modified. The access point configurations may be sent to you in 
a smart message by your wireless service provider. You may also be able to add new 
access points.

To view, edit, or add new access points, first you must obtain the configurations from 
both your wireless and Internet service providers to be entered into the phone.

From Settings application:
1. Open Settings.
2. Scroll to Connection and open.
3. Open Access points to view a list of existing access points.

• D icon  indicates data call. G icon  indicates GPRS packet data connection.
4. To add a new access point, press Options and select New access point > Use 

default settings or Use existing settings. Either build a new access point from 
preset default settings, or use an existing access point to edit as needed. 
• To edit an access point, press Options and select Edit.

Active clamshell Select On to answer a call by opening the flip clamshell and to 
disconnect phone calls by closing the flip clamshell. When set to 
Off and you close the flip clamshell during a call, the caller’s 
voice switches to the back loudspeaker.

Line in use This setting appears if you have subscribed to Alternate Line 
Service, in which you can have two different phone lines with the 
same SIM card. Select Line 1 or Line 2.

Line change This setting appears if you have subscribed to Alternate Line 
Service (see Line in use setting). You can disable selection of 
one of the phone lines. The PIN2 code is required to return use 
of a previously blocked line.
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5. Enter information in fields. Fields marked in the phone with a red asterisk (*) must 
have an entry. The bearer type you choose determines which fields are presented. 

6. From main fields, press Options and select Advanced settings to enter:   

* Connection name Enter an easy-to-recall name if not assigned.
Data bearer Select GPRS or Data call.
* Dial-up number 
(Data call only)

Enter access point dial-up phone number. 

Access point name 
(GPRS only)

Enter name supplied by service provider. 

User name Type a user name, supplied by service provider, if required.
Prompt password To have the phone ask for the password each time you log on, 

select Yes.
Password Type in password, supplied by service provider, if required.
Authentication Select Normal or Secure.
Homepage Type in Internet web address of service.
Data call type 
(Data call only)

Determined by your wireless and Internet service providers. 

Maximum data speed  
(Data call only)

Choose a limit for your connection speed if you are charged 
more for higher speeds.

Phone IP address Enter IP address assigned to your phone, if static or dynamic. 
Service provider determines if IP address is static or dynamic.

Primary name server Type in primary domain name server IP address.
Second. name server Type in secondary domain name server IP address.
Proxy serv. address Enter the proxy server address for access point.
Proxy port number Type in proxy port number for access point.
Use callback 
(Data call only) 

Select Yes to use dial back servers.

Callback type
(Data call only)

Select Use server no. for callback, or Use other no.

Callback number  
(Data call only)

Enter the phone number the callback server should use.

Use PPP
compression
(Data call only)

Select Yes to use PPP (Point-to-Point Protocol) compression. 

Use login script
(Data call only)

Select Yes to use login script defined in Login script field.
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GPRS Settings
From Settings application:
1. Open Settings.
2. Scroll to Connection and open.
3. Scroll to GPRS and open.
4. Open to edit:  

Data Call Settings
From Settings application:
1. Open Settings.
2. Scroll to Connection and open.
3. Scroll to Data call and open.
4. Open Online time. Choose a time period to disconnect from the data call if there is 

no activity.

DATE & TIME SETTINGS
Date and time settings can be made from the Clock menu. See Clock on page 103.

Login script 
(Data call only)

Enter the login script to be used. 

Modem initialisation 
(Data call only)

If desired, enter a modem initialisation string (AT command 
string).

Note: If your wireless service provider has protected some of your 
settings, you may not be able to modify them.

GPRS connection Choose When needed to connect to GPRS service only when 
you open an application that uses GPRS. After you close the 
application, GPRS service will disconnect.
Choose When available to stay continuously connected when 
you are in a GPRS service area, in which the GPRS icon  
replaces the signal strength icon .

Access point Choose an access point supplied by your service provider to use 
the phone as a modem to enable GPRS connection from a com-
puter.

Note: If you selected to attach to GPRS when available and are in 
an area without GPRS service, then the phone will attempt 
to connect to GPRS service periodically.
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SECURITY SETTINGS
Phone and SIM
Your phone and SIM card have security codes that you can use to limit access to the 
phone. Keep a written record of your codes in a secure place.
• Enter PIN code to use phone
The PIN and PIN2 codes (4 to 8 digits), issued by your wireless service provider, protect 
your SIM card against unapproved use.

If you set PIN code request to On, then the PIN code must be entered each time the 
phone is turned on.

The PIN2 code is required to access certain wireless service provider services such as 
Fixed dialling and Call costs. If the PIN2 code is blocked, use the PUK2 code to unblock.

The PIN and PIN2 codes affect only the current SIM card as they are stored in the SIM 
card, not the phone memory.
From Settings application:
1. Open Settings.
2. Scroll to Security and open. Open Phone and SIM.
3. Scroll to desired setting and select:   

• Enter Lock Code to Use Phone
To prevent unapproved use, you can lock the phone. When the phone is locked, the lock 
code must be entered before the phone can be used. The phone lock icon  indicates 
that the phone is locked.

To unlock the phone, enter the lock code. You may be able to dial the local emergency 
number and accept incoming calls when the phone is locked.

Activate Phone PIN Select Yes to require entry of PIN code each time the phone is 
switched on. Requires PIN code to activate.

PIN code To change PIN code, enter current PIN code, then new PIN 
code twice. Press OK.

PIN2 code To change PIN2 code, enter current PIN2 code, then new PIN2 
code twice. Press OK.

Note: If PIN or PIN2 code is entered incorrectly 3 times, the SIM card 
locks. Contact your wireless service provider for PUK or PUK2 
code (PIN unblock key code). If the PUK or PUK2 code is entered 
incorrectly 10 times, the phone will not operate. All information 
stored in the SIM card is lost and the SIM card must be replaced.

Shortcut: To lock the phone, press  and select Lock phone.
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From Settings application:
1. Open Settings.
2. Scroll to Security and open. Open Phone and SIM.
3. Scroll to desired method and select:   

• Fixed Dialling and Closed User Group
Fixed dialling restricts outgoing calls to ‘fixed numbers’ contained in SIM cards that 
support this feature. When switched on, dialling any number not on the Fixed dialling list 
is not allowed. Call diverting and sending messages to any numbers not on the list is 
also not allowed. The PIN2 code is required to set up and use this feature.

Once you enter Fixed dialling, press Options and select New contact or Add from 
Contacts to add a phone number to the Fixed dialling list. You can also call, edit, and 
delete numbers in the Fixed dialling list.

Some wireless service providers offer Closed User Group feature, which allows the 
phone to make and receive calls only from specific groups. The groups are set up with 
your wireless service provider at time of subscription purchase. 
From Settings application:
1. Open Settings.
2. Scroll to Security and open. Open Phone and SIM.
3. Scroll to desired method and select: 

Autolock period Set the phone to lock after a time period of no activity. Select 
User defined to type in time period in minutes. Requires lock 
code to set.

Lock code To change lock code, enter current lock code, then new lock 
code twice. Record the new code in a safe place. The preset 
lock code is 12345.

Lock if SIM changed To prevent the phone from being used if an unknown SIM card is 
inserted, select Yes. 

Caution: If you change the lock code then cannot recall it, your wireless 
service provider cannot identify the code. The phone must then 
be reset at an authorised service center. 

Fixed dialling Enter PIN2 code. Press Options and select New contact or 
Add from Contacts to create the fixed dialling list. Press 
Options and select Activ. fixed dialling to activate the service.

Closed user group Select Default to activate the service to the default group previ-
ously set up with your wireless service provider. Select On to 
activate another group set up previously.
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Certificate Management
Certificates are attachments to electronic messages used to verify senders and 
recipients of data over nonsecure networks, such as e-mail servers or the Internet. Two 
types of certificates your phone stores are authority and personal. 

Authority certificates are downloaded to your phone and are used to check server 
certificate signatures and to guarantee that the certificate is issued by a certification 
authority (CA).

Personal certificates are issued to you by a certification authority.

Certificates are valid for only a fixed time period and must be renewed periodically. To 
renew, contact the certificate issuer.

Before downloading or sending confidential information, check the digital signature and 
validity period of the browser gateway or server on the certificate.

The phone will issue a note if the browser or server identity is not authentic, or if you do 
not have the correct certificate in your phone.

• View Certificates
From Settings application:
1. Open Settings.
2. Scroll to Security and open.
3. Scroll to Certif. management and open.

• A list of authority certificates displays.
4. Press Options and select Certificate details.

• A list displays with details such as issuer, subject, validity period, certificate 
location, certificate format, algorithm, serial number and fingerprint. 

• Authority and personal certificates will show different information. If the personal 
certificate is on an outside server, it will have different details.

5. Scroll  to view personal certificates if available.

• Trust Settings
Check whether certain applications (Browser, Application Manager, or Internet) can use 
a selected certificate.

Confirm SIM services Select Yes to view confirmation messages sent between your 
phone and the network when you are using SIM application tool 
kit services.

Delete server You can reset the trusted provisioning server setting if you have 
received settings in a message. Contact the service provider 
from which you wish to receive new settings.
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